THANK YOU FOR CHOOSING FLUX,
ITIS A GREAT HONOR FOR OUR TEAM.

The FLUX HEXA is our newest generation flagship
machine that brings together our years of experience
in laser technology. We know that good maintenance
will keep your machine in top condition for years
to come. In this manual, you will learn how to use
your HEXA, and how to make the most of the laser
processing characteristics of various materials.
If you have any questions about the operation of
your machine, please feel free to contact us via our
website. Finally, we would like to thank our customers,
partners, and friends again for your trust as we
continue to strive to bring you the very best user
experience.

Cheers,
FLUX Team
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Before
Getting
Started



CH 1-1
Labels

The HEXA has 6 labels in total. Warning labels
describe potential risks. Please familiarize
yourself with all safety guidelines before use.



|l CH1-1Labels

L 1. Product label J 2. Laser light warning label

e please avoid eye or skin exposure to
laser beam.

AVOID EYE OR SKIN EXPOSURE

& | isible Laser Radiation Is Emitted
From This Aperture.

Q FLUX HEXA

Manufactured Date : October 2021

On the right side of the first reflective
mirror outlet (circle outlet)

CAUTION
CLASS 4 INVISIBLE LASER RADIATION WHEN OPEN

. AVOID EYE OR SKIN EXPOSURE TO DIRECT OR
:;;t;tc.‘ -8&%(\)/\_/]27\/ @ 200-240V AC 50/60 Hz A TEREOASTeIoN
Model Number : FHX1
On the left and back side of the

CLASS 1 LASER PRODUCT machine
CLASSIFIED IEC 60825-1 2014
Complies with 21 Chapter 1, Subchapter J.

CAUTION

CLASS 4 INVISIBLE LASER RADIATION
WHEN OPEN AND INTERLOCKS DEFEATED

FLUX Technology Inc.

3F, No. 89, Ln. 298, Huandong Rd., c E F@
Yangmei Dist., Taoyuan City, Taiwan

Made In Taiwan flux3dp.com

AVOID EYE OR SKIN EXPOSURE TO DIRECT OR
SCATTERED RADIATION

@ On the bottom right corner of the back Below the screen
of the machine

3. Fire hazard warning label ’

e please do not operate machine
unattended

DANGER
FIRE HAZARD

DO NOT OPERATE MACHINE
UNATTENDED

REFER TO THE USER MANUAL FOR ADDITIONAL
INFORMATION REGARDING MATERIAL SAFETY

@ Below the screen
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CH 1-2
Safety
Precautions

Please read the following safety precautions
carefully before operating the HEXA. Since the
HEXA generates a high-power laser, improper
operation may result in fire, visual impairment,
skin burns, inhalation of toxic substances, and
other harmful or adverse health effects to per-
son or property.



| CH 1-2 safety Precautions

Please consult FLUX regarding any usage or safety concerns.
support@flux3dp.com / (+886) 2651-3171

Do not stare at the light produced by the Please confirm the material to be engraved
laser while the machine is cutting and will be safe to burn at high temperatures.
engraving.

Always have an accessible, functioning fire Do not disassemble the HEXA without prior
extinguisher in the work space. authorization from FLUX.
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Operators

Confirm that users intending to operate the machine have read all safety
precautions carefully and will follow the instructions in the manual.

x DO NOT let minors operate the HEXA alone.

% Working Environment

- Place the machine on a level, stable surface, ensuring there is no overhang
or tilt.

+ Place the machine in a well-ventilated indoor space with windows. Do not
place the machine outdoors, in the basement, under a metal roof, or in other
confined spaces.

- Set the open end of the HEXA'’s vent hose outside of a window.

- In case of rain or extreme weather, please stop using the machine and put

O the vent hose away indoors. Do not expose the machine to high humidity,
splashing rain, or direct sunlight.

- Stored the machine at an ambient temperature between 5°C and 40°C and
humidity between 10% and 70%.

* The HEXA should be operated at an ambient temperature between 5°C and
25°C (if the power is below 40%, the ambient temperature may be be relaxed
to as high as 30°C).

x + DO NOT place any liquids or flammables near the machine.
+ DO NOT let children play near the machine.
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| CH 1-2 safety Precautions

Q@ Safety Switch

- Lifting the door cover should trigger the safety switch to suspend the
operation of the machine and stop the output of the laser. If the machine
fails to suspend operation after the cover is lifted, please stop using the
machine, turn off the power, and contact customer service immediately.

« For your safety, do not put your hands, eyes, or other parts of your body
near the operating area of the laser.

- When adjusting the optical path, please make sure to close the door cover
before testing to prevent injury in case the safety switch fails.

+ DO NOT operate the machine in case of safety switch failure.
- DO NOT try to disable the safety switch.

Power and Wires

+ Verify that the model you received is the correct voltage (110V or 220V).
+ Ensure that the 3rd prong of the socket is grounded. An ungrounded circuit

- If the power cord is damaged, stop using the machine immediately.
+ Always turn off the power and disconnect the plug before cleaning. Do not

may cause static interference, affect performance, or increase the risk of
electric shock.

try to service or disassemble the machine without authorization from FLUX.

X

DO NOT bend, twist, pull, or put heavy objects on the cables or plugs.
Keep cables and plus away from heat sources.
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Fire Risk

+ Regularly clean the debris under the honeycomb table of the machine.
+ In case of fire, turn off the power immediately and unplug the power cord.
Use a wet towel to extinguish the fire. Note: water may irreversible damage

the machine.

O - If the fire is relatively large, use a fire extinguisher. Note: the dry powder
or foam from the fire extinguisher may cause irreversible damage to the
machine.

- If the fire spreads, please call the fire department immediately for assis-
tance.

+ Please see “Material Tips - Hazardous Materials (p.111)” for a list of materials
that are not suitable for lasers processing and for more information.
x + DO NOT try to cut multiple boards at once by stacking materials in the
machine.
+ DO NOT operate the machine unattended.

:DQ Ventilation

+ Set the open end of the HEXA'’s vent hose outside of a window or connect

to an air purifier.

O * If you detect strong odor or heavy smoke, please stop using the machine.
Make sure the vent hose is properly connected and the ventilation system
is working properly before use.
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| CH 1-2 safety Precautions

Additional Operation Notes

+ Have two or more people move the machine to avoid injury.

+ Wearing gloves while cleaning honeycomb table or material to avoid
being scratched.

» In case of burns, please flush with cold water and consult a doctor
immediately.

+ Wear a mask and laser safety glasses with the protection level of OD5
(energy penetration rate 10°) when opening the cover.

+ DO NOT stare at the light produced by the laser during operation.
+ Strong vibrations may cause the optical path to shift or the laser tube
to be damaged.
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CH 1-3
Product
Specifications

This manual is applicable to HEXA.
Software version: 1.9.X.

Firmware version: 4.0.X.

The illustrations are mainly for macOS.






Laser
Specifications

HEXA

Upgraded Design

Beambox ®

Wide Operating Space
Industrial Engraving

Laser power 60W 50w

Cutting thickness* 10mm 8mm

Working depth 125mm 80mm
Maximum

engraving speed 900mm/s 300mm/s
Weight 58kg 48kg
Wavelength 10640nm 10640nm
Machine

S|

Size ettt 1110x670x273mm 990x670x250mm
Maximum

working area 730x410mm 600x375mm
Camera 730x395mm 600x360mm

preview area

Touch panel
Camera lens

Transmission

7" 1024 x 600 LCD

2 Mega pixels

1024 x 600 LCD

2 Mega pixels

Wi-Fi / Ethernet /JUSB Wi-Fi / Ethernet

interface

Add-on

Rotary @) O
Autofocus Built-in

Diode laser module

Software

File format

Operating system
and browser

JPG / PNG / SVG / DXF / Al / PDF

Windows / macOS / Linux / Chrome / Safari*

*: Cutting thickness (Cut an acrylic sheet once with Power: 70% and Speed: 5mm/s)
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Beambox

Wide Operating Space
Industrial Engraving

| CH 1-3 Product Specifications

beamo

Compact Size
Detachable Bottom Cover

40W 30W

5mm 3mm

80mm 45mm
300mm/s 300mm/s

40kg 22kg

10640nm 10640nm
800x670x250mm 615x445x177mm
400x375mm 300x210mm
400x360mm 300x195mm

1024 x 600 LCD

2 Mega pixels

Wi-Fi / Ethernet

1024 x 600 LCD

2 Mega pixels

Wi-Fi / Ethernet

O O

JPG / PNG / SVG / DXF / Al / PDF

Windows / macOS / Linux / Chrome / Safari*

**: Supported devices for browser version are those with either viewport width or

height over 1024 pixels.
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CH 1-4
Laser Engraving
Principle

Laser engraving focuses a high-power laser
beam on the surface of the engraving material
that instantly heats or vaporizes the material to
create an indentation or a cut in the path of the
laser beam.
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| CH 1-4 Laser Engraving Principle
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Laser Principle

Optical Path

EO

First Reflective Mirror

Third Reflective
Mirror

Second Reflective Mirror

Reflective Mirrors

There are three reflective mirrors inside the machine. The
position of the first mirror is fixed, while the motor can
move the second and third mirrors to direct the laser beam
to any position on the work table. The second mirror moves
forward and backward along the Y-axis, while the third
mirror moves left and right along the X-axis.
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| CH 1-4 Laser Engraving Principle

=

Laser Tube

The HEXA is equipped with a 60W CO2 laser. The electric
current excites the CO2 gas inside the sealed glass tube to
produce an invisible laser with a wavelength of 10.6 um. The
light emitted from the end of the laser tube is about 5 mm in
diameter. Due to its small divergence, this laser beam can be
transmitted inside the machine with little energy loss.

[ Exploded view of laser head ]

Focus Lens

The third reflection directs the laser beam to the surface of
the engraving material. A glass focus lens inside the laser
head focuses the beam of about 5mm diameter to about
| | 0.2mm diameter to create a higher energy density that is
sufficient to instantly burn through non-metallic materials
:) such as wood and acrylic, metal materials after anodizing, or
stainless steel after specific spry processing.
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Start



CH 2-1
Unboxing

Two or more people are required to lift
the machine to avoid injury.



o1
02
03

| CH 2-1Unboxing

The box contains the machine and the accessory box.

Take the machine out the box and place it on a stable surface. Please keep the
original carton and cushioning material for future use.

The accessory box contains : 1| Torx screwdriver, 2 | 2.5mm hexagonal wrench,

3 | 3mm hexagonal wrench, 4 | Double head wrench, 5 | Lubricating oil, 6 | Funnel,
7 | Vent hose, 8 | Power cord, 9 | Double-sided tape, 10 | Clamp, 11 | USB cable,

12 | Wi-Fi dongle, 13 | Pyramid cones, 14 | Manual, 15 | Wood piece, 16 | A4 (Letter
size) paper.




04 Machine front :

1 | Laser head, 2 | Honeycomb table,

3 | Probe, 4 | Height adjustment button,
5

| Door cover, 6 | Touch panel, 7 | Power button.
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| CH 2-1Unboxing

O 5 Machine rear :

1 | USB-A port
| USB-B port
| Ethernet port

| Power supply

Water pump cover

O 01 A WNN

Ventilation fan and
exhaust port

0 6 Machine right :

1 | USB-A port

029



CH 2-2
Assembly and
Setup

Please read the safety precautions carefully
before operating the machine.



| CH 2-2 Assembly and Setup

Prepare machine for use.

o1
02

03
04

05

Plug the power cord into the rear of the machine and into the outlet.

Place the clamp from the smaller end of the vent hose and thread through to the
larger end. Place the larger end of the vent hose into the exhaust port. Tighten
the clamp using the provided double head wrench until the vent hose is secure.

Turn on the machine by pressing the power button. The first startup may take up
to two minutes.

Follow the machine prompts:

a. Select interface language > b. Read fire hazard warning carefully (as shown on
the next page) > c. Run the Startup Test > d. Set up the internet connection > e.
Tear off 2 mirror protective films. Please refer to [Connection Settings] (p.48)
for other connection methods. Make sure the machine and any connected devices
are on the same local area network.

After setup, please must fill the water tank to 80% full to ensure the normal
operation of the water cooling system. Insufficient water in the cooling system
will damage the laser tube. Please refer to the user manual [5-4 Water changing
and adding] (p.171) step8 for more detail.

Before engraving, you must select the language and network on the
machine. You must also download and set up the software in order to
pair the computer and the machine.




Q 24°C X ~ =

FIRE HAZARD

Refer to the user manual for additional
information before using your FLUX Laser

* Do not stare at the flame generated by the
laser.

* Do not operate machine unattended.

* Do not try to service, repair, or modify the
machine without authorization from FLUX
Support.

* Be sure to have a properly maintained fire
extinguisher near the machine at all time.

* Please make sure that the processed
material does not pose a hazard when
burned at high temperatures.

* Periodically remove the cutting grid and
clean debris from the work area.







CH 2-3
Machine
Interface

Introduces the machine interface and the
seven key functions.



A_

| CH 2-3 Machine Interface

.

H
“ START

MAINTENANCE

APP

NETWORK

it

MACHINE

1 I- @ Help Center
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Status Bar

Check the machine status

START

Manage work files

MAINTENANCE

mode, repair and troubleshooting

APP

Pairing mobile devices to machine

NETWORK

Check network status, network settings

MACHINE

Machine details, language,

and hardware related settings

G ! HELP CENTER

036

Help Center access




| CH 2-3 Machine Interface

A : Status Bar

Check the machine status

The status bar shows the temperature, whether it is connected to Beam Air, water flow,
and door cover opening/closing status, as well as network connection type of the machine.
Generally, clicking the status bar returns to the home page, and while carving will refresh the
page.

R 28°C = W W T

Status Bar Icons

Temperature i
b / Temperature [p):le Beam Air BA
Beam Air connected
Standb
Water pump In Progress g v :?/:E
Cover Cover —_
(o4
over open E closed
Draven Drawer open Drawer
closed
Netwc.Jrk Wireless = Ethernet @
connection network Kol network

037



B : START

There are two ways to transfer the working tasks, either via Beam Studio software or by
USB flash drive. Either method can be used to find and use the files from "START" after
transfer.

)
(=}
1)

Q

<€ Back

M Parent

. recent-0Ol.fc

_ recent-02.fc

_ recent-03.fc

_ recent-04.fc

1 RECENT-O1.FC

' recent-05.fc Time Cost: 1Tm 1's

) recent-06.fc a
S [z | [z |
Power Rate Speed Rate

_ recent-08.fc

1. Tasks sent to the machine from Beam Studio : “Built-in Memory” > “Recent” >
specific tasks.
The machine can store up to 15 tasks sent by Beam Studio, and recent-01.
fc will be the latest task sent.

_ recent-09.fc

2. Files read from USB flash drives : USB flash drive > specific tasks.
There is no limit to the number of files that can be viewed on a USB flash drive.
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| CH 2-3 Machine Interface

Manage work files

Select the file to display the real position of the image in the working area, the estimated
processing time, and the real-time power and speed rate.

RECENT-O1.FC

Time Cost: 1Tm 11s

Bt

<€ Back

The origin point may be manually set before processing, and the power rate and speed rate
can be set at any time during the process.

To set the start point manually, c\icka, then move the laser head from the starting position

(0,0) to the desired position, then click OK.
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C : MAINTENANCE

Toggling maintenance mode,

During maintenance
and repair, enter the
MAINTENANCE page.
This is intended mainly
for hardware switch
and signal display. It is
highly recommended
to operate this page
only after reading the
subsequent mainte-
nance chapter and/or
under the guidance of
customer service.

040

repair and troubleshooting

€ Back

Camera Power x 1.00 Speed = 1.00

Motors Air Pump Pump Ventilator

Backlight TouchSig Cam Led Work Led

Laser Pulse



| CH 2-3 Machine Interface

D: APP

Pairing mobile
devices to machine

Download the Beam Go
app and connect your
mobile device to the
same wireless network.
Click on the APP and
scan the QR code to pair
your mobile device with

e
)

your machine.

Connect Beam Go

*Beam Go is the mobile
version of the Beam
Studio.
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E: NETWORK

Check network status,

This screen displays the network IP address and
confirms whether the connection via Wi-Fi or
the Ethernet cable is active (the MAC address
for the active interface will have a value).

Advanced Settings : Manually assign a Static
IP for the machine in this menu, including the IP
address, subnet mask, and gateway.

Start Remote Assistance : Initiate a guided
support session with customer service.

< Back < Back

Wireless Network Advanced Settings e T
TCP/IP Setting Set Static IP Address

Ethernet Advanced Settings 1P Address 192.168.16.234%)

Subnet Mask 255.255.255.0 (4
TCP/IP Setting Router 192.168.16.1 &

network settings

.,))

Q

<€ Back

Built-in Wireless Network
Wireless IP 192.168.1.39
MAC Address e8:4€:06:80:7c:42

Wired Network
Ethernet IP
MAC Address e4:5f:01:2b:a9:45

Remote Assistance

Connect to WiFi

Connect to Other WiFi

Advanced Settings

Start Remote Assistance

4 5 6 o =
<€ Back
7 8 9
o] <«

IP Address 192.168.16.234 &
Subnet Mask 255.255.255.0 (4

Router 192.168.16.1 &
v X
- Apply Settings

Note: When using a wireless (Wi-Fi) or wired network (except for direct connection), the
machine automatically obtains an IP address through DHCP or can be manually assigned a

Static IP.
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| CH 2-3 Machine Interface

F : MACHINE

Machine details, language,
and hardware related settings

If you have any issues, refer to section G : Help Center.

© = o 2
< Back <€ Back

Name HEXA (&

Machine Serial FLCOLFECUC English

CPU Serial 9WMB-AF3F-FJET-FXX8

Firmware Version 4.0.0 Model fhexal ERPX

Ventilator Rotation Speed 100%

Laser Tube Usage 0.02 h B

Hardware Settings

BA5E

Ul Theme Settings

II

Deutsche

Language Settings Portugués

Password Settings _
Espafiolas

Reset Laser Usage

Dutch

Reset to Factory

Update to the latest Firmware

CAUTION : Do not use the “Hardware Settings”, “Reset Laser Usage”, or
“Reset to Factory” settings without express instructions from customer
service to avoid damaging the machine.

o

N
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Machine details, language,
and hardware related settings

Once the connection password is set, you must enter the connection password when
connecting to the machine for the first time. The password can be modified or disabled.

= —
=

€ Back € Back

i

Name HEXA (%
© Boot Password
Machine Serial FLCOLFECUC

CPU Serial 9WMB-AF3F-FJET-FXX8 Set Boot Password

Firmware Version 4.0.0 Model fhexal
Ventilator Rotation Speed 100% Connection Password

L T .02
aser Tube Usage 0.02 h Set Connection Password

Hardware Settings

Ul Theme Settings

Language Settings

Password Settings

Reset Laser Usage

Reset to Factory

Update to the latest Firmware

Update the firmware to the latest version by clicking “Update to the latest Firmware”. You
can also update the firmware through the software interface (See [Software Operation]
“Menu” - “Machines” (.89))

Alternatively, you may update the firmware from a USB flash drive. The storage size must be
<= 64GB, formatted as FAT32. Rename the firmware file downloaded from the website as
autoupdate.fxfw. Plug the USB flash drive into a USB port then restart the machine.

The firmware upgrade process takes a few minutes. Do not turn
off the machine during the process.
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G : HELP CENTER

Help Center access

If you have any questions, please click "HELP CENTER", scan the QR code, and search the
Help Center on the FLUX official website for possible solutions.

Q & support.flux3dp.com

Help Center

Ofr A0
' T

beamo Guide

Beambox Guide
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CH 2-4

Software
Installation
and Activation

Download the latest version of Beam Studio
from the official FLUX website.



| CH 2-4 software Installation and Activation

Please go to the official FLUX welbsite > “Support” > "Downloads” and select the appropriate
version of Beam Studio from the drop-down list based on your operating system.

Beam Studio ( beamo / Beambox / Beambox Pro / HEXA )

Beam Studio - Stable

@ (v1.9.3 - macOS 10.13+ v) Download

OS Requirement:
Windows 10 / macOS 10.13 / Ubuntu 16

For macOS

Make sure you select the correct macOS version. Some features are not available
on older versions of macOS. To verify your system version, select Apple Menu & >
“About This Mac” > Version. Once the download is complete, open the file from the
Downloads folder. Drag the application icon into the Applications folder, and open
Beam Studio.

If you are unable to open the file because it is from an unidentified developer,
open “System Preferences” > “Security & Privacy”, click on lock to modify >
“Open Anyway”.

-
-

~
/

For Windows

Make sure you select the correct operating system architecture: X86 for 32-bit
and X64 for 64-bit. Once the download is complete, please run the installer. Beam
Studio can be opened from the desktop or from C:\Users\User\ AppData\Local\
Programs\beam-studio\Beam Studio.

- /

[Troubleshooting] Unable to Open Software Properly ( p.209 )
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CH 2-5
Connection
Settings

Explains the various connection installation
methods. Once the machine is connected, it
can be operated from the computer.



| CH 2-5 Connection Settings

There are four ways to connect the machine to a computer: Wi-Fi, Wired Network, USB

Connection, and Direct Connection.

=

Wired Network

Necessary equipment
(Embeded in the machine) :

- Built-in WiFi (2.4 / 5 GHz)

(Included in the accessory box) :

- WiFi dongle (2.4 GHz)

Necessary equipment
(Not included) :

-RJ45%
(machine ~ router)

-RJ45*2 + router*]
(machine ~ router / computer ~

router)

.

USB
Connection

J

Direct
Connection

Necessary equipment
(Included in the accessory box) :

- USB cable (USB-B to USB-A)

(Not included) :
- USB-A to USB-C adapter

Preparation Items
(Not included) :

- RJ45%
(machine ~ computer)

- Plugable USB/USB-C to Ethernet
adapter
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1 WI-Fi :

—

a. Set up the machine network [you must use the same Wi-Fi (2.4GHz) as your computer
network] :

Select “NETWORK” > “Connect to Wi-Fi” and select the Wi-Fi you want to use. Then enter

the Wi-Fi password and press “Confirm” > “NETWORK?”. Confirm the “Wireless IP” of the

machine.

*If it didn’t show your Wi-Fi name :

- Make sure your WiFi is Public. If not, please select “NETWORK” > “Connect to Other
WiFi” > Enter the network name > Choose a security level > Enter the Wi-Fi password
and press “Confirm”

- Insert the Wi-Fi dongle and set antenna at 90 degrees to side USB port on the side of
the machine to improve signal reception.

b. Select the software interface display language :
Use the drop-down list to select the language and then click “Next”.

c. Log in to your member account :
Log in to benefit from added functionality and improvements of software updates.

d. Select the connection method :
Select "Wi-Fi".

e. Enter the IP address of the machine to complete the setting :
Enter the IP address of the machine to complete the setup process.

2 Wired Network

a. Connect the Ethernet cable :
Connect the Ethernet cable to the Ethernet port on the rear of the machine and to the
router. The machine will automatically connect to the network once the installation is
complete.

b. Confirm the machine network :
Confirm the value of Wired Network “MAC Address” of the machine on “NETWORK” page.

c. Select the software interface display language :
Use the drop-down list to select the language and then click “Next”.

d. Log in to your member account :
Log in to benefit from added functionality and improvements of software updates.

e. Select the connection method :
Select "Wired Network”.

f. Enter the IP address of the machine to complete the setting :
Enter the IP address of the machine to complete the setup process.
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| CH 2-5 Connection Settings

3 USB Connection [

You can also connect to the machine directly via an USB cable.

1. Windows :

a. Connect the USB cable :
Connect the USB cable to the USB-B port on the rear of the machine and then connect the
USB-A side to the computer. The machine will automatically connect to the network once
the installation is complete.

b. Confirm the machine network :
Confirm the value of Wired Network “MAC Address” of the machine on “NETWORK” page.
Click “Settings” > "Network & Internet” > Ethernet - “Properties”. Verify that the IPv4 DNS

servers is set to 10.55.0.17.

4 FLUX Dev
A
i'" “] Metwork & Internet
Documents e e - .
O N Wi-Fi, airplane mode, VEN
B Pictures
e Settings
@ Gaming
|
O Power ¥box Game Bar, captures, Game
R Mode
|| P
WLAN (FLUX Office) 9.02 GB
. f?: From the last 30 days
Properties
Properties Data usage
Link speed (Receive/Transmit): 425/425 (Mb,
Link-local IPvé address: feB0:c9c8: c2:d184%41
~ Ethernet 1.49 GB

IPv4 address:
IPv4 DNS servers:

From the last 30 days

Manufacturer: Microsoft l Properties l Data usage
Description: Remote NDIS Compatible Device #3
Driver version: 10.0.19041.1

Physical address (MAC): 32-FF-FF-FF-FF-10

Copy —
A

c. Select the software interface display language :
Use the drop-down list to select the language and then click “Next”.

@ Show available networks
View the connecticn options around you,

dvanced network settings

d. Log in to your member account :
Log in to benefit from added functionality and improvements of software updates.
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e. Select the connection method :
Select "USB Connection”.

f. Enter the IP address of the machine to complete the setting :
Enter the IP address of the machine, 10.55.0.17, to complete the setup process.

2. masOS :

a. Connect the USB cable :
Connect the USB cable to the USB-B port on the rear of the machine and then connect the
USB-A side to the computer. The machine will automatically connect to the network once
the installation is complete.

b. Confirm the machine network :
Click “System Preferences” > “Network” > Status of USB HEXA 2 LAN: Connected.

[ ] < i Network Q

Location: Automatic

) USB Bea...box 2 LAN

Connected Status: Connected

— USB Beambox 2 LAN is currently active and
= Wi-Fi has the IP address 10.55.0.5.
*_ @ Connected

Bluetooth PAN
@ Not Connected

> USB 10/1...1000 LAN IP Address: 10.55.0.5
@ ot Connected Subnet Mask: 255.255.255.248

Configure IPv4: Using DHCP

¢ Thunderbolt Bridge
@ Not Connected Router:

DNS Server:

Search Domains:

Advanced... ?
+|—|©v

c. Set the software interface display language :
Use the drop-down list to select the language and then click "Next”.

d. Log in to your member account :
Log in to benefit from added functionality and improvements of software updates.

e. Select the connection method :
Select "USB Connection”.

f. Enter the IP address of the machine to complete the setting :
Enter the IP address of the machine, 10.55.0.1, to complete the setup process.
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| CH 2-5 Connection Settings

4 Direct Connection | |

You can also connect directly to your computer via an Ethernet cable.

1. Windows : (This method applies to Windows 10)

a. Connect the Ethernet cable :
Connect the Ethernet cable to the Ethernet port on the rear of the machine and the
computer.

b. Confirm the machine network :
Confirm the value of Wired Network “MAC Address” of the machine on “NETWORK” page.

c. Enable Internet connection sharing :
Click “Settings” > “Network & Internet” > “Change adapter options”.

local network, but may not be able to reach the Internet. If y¢
have a limited data plan, you can make this network a meterd

jmy System connection or change other properties.
Display, sound, notifications,
Documents pover Change connection propertes
Show available networks
P|CtU res @ N?tWC-II'k & Internet )
WiFi, flight mode, VPN Change your network settings

(@ Change adapter options

View network adapters and change connection settings

R Accounts &, Sharing options
Your accounts, email, sync, For the networks that you connect to, decide what you wan!
work, family

A\ Gt tips, tricks, and suggestions as you use Windows
Diagnose and fix network problems

iew your network properties
((17. Ease of Access
= Narrator, magnifier, high dows Firewall

contrast

Network and Sharing Centre

Right-click on the network you are using (Wi-Fi or Ethernet) then click “Properties” >
“Sharing”. Check the boxes next to "Allow other network users to connect through this
computer's Internet connection” and “Allow other network users to control or disable the
shared Internet connection”.

". Wi-Fi 4 " Ethernet
=-.,;"£m FLUX - SW !; Disable ble unplugged
TP-Link Wireless . o ernet Connection (2) 12...
rrreek=EiS conne
Status
Diagnose

Bridge Connections

Create Shortcut
Delete

Rename

Properties -
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N o . 7
U wiris Properties U Wi-Fi 4 Properties
Networking Networking Shaning
Connect using: Intemet Connection Sharing
1i . T Allow other network users to connect through this
? TP-Link Wireless MU-MIMO USB Adapter @ whralhrpints gl
E Home networking connection:
This connection uses the following items: | Select a private network connection
aClient for Microsoft Networks low other network users to control or disable the
¥ T Fie and Prnter Shanng for Microsoft Network: Sharod intemet connocion
¥ %8 QoS Packet Scheduler o
3 Tarogic NDIS Monitor Driver ==
™ ¥ Npcap Packet Driver (NPCAP) (Wi-Fi)
W T8 Npcap Packet Driver (NPCAP)
% Nocap Packet Driver (NPF)
<
istal. | | Uninstal | | P
Description
2RO E IEAESTFRY Microsoft SR8 _EAYEIE -
B

After confirmation, the word “Shared” will be displayed under that network.
In the “Network Connections” window, you will see an “Unidentified network”, which is the
network to which the machine is connected.

- O X
BR4EFE > Network Connections » v D £ Search Network Connections
is network device Diagnose this connection Rename this connection 2 Ei - [ 0
B~ Wi-Fi4 = Ethernet
% FLUX - SW, % _ Network cable unplugged
TP-Link Wireless MU-MIMO USB ... Intel(R) Ethernet Connection (2) I2...

d. Select the software interface display language :
Use the drop-down list to select the language and then click “Next”.

e. Log in to your member account :
Log in to benefit from added functionality and improvements of software updates.

f. Select the connection method :
Select “Direct Connection”.
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g. Enter the IP address: :
Confirm the “Wired IP” address of the machine from the panel. Enter the wired IP address
of the machine into the computer to complete the setup process. It usually starts with
192.168.(If it starts with 169.254, it means the computer may be set up incorrectly or the
network cable).

2. macOS: The method is applicable to macOS environment. If you are using macOS
Catalina, please update to at least 10.15.4.

a. Connect the Ethernet cable :
Connect the Ethernet cable to the Ethernet port on the rear of the machine and the computer.
b. Verify the machine network :
Verify that the machine has a value for Wired Network “MAC Address” on the “NETWORK”
page.

c. Turn off the computer firewall:
Click “System Preferences” > “Security & Privacy” > “Firewall” > “Turn Off Firewall”.

° #E System Preferences ° < H Security & Privacy Q Search

- General  Filevault Firewall  Privacy
- Firewall
ApplelD  Family _—
Sharing Firewall: Off

This computer's firewall is currently turned off. All incoming connections to this
computer are allowed.

i~ W ma 9 Q u g

General Desktop & Dock & Mission siri Spotlight  Language  Notifications
Screen Saver  Menu Bar Control & Region
7 I~ 1

G =2 9 & I w ®
Internet Wallet & Touch ID Users & Accessibility Screen Time Extensions Security
e @ S
Software Network Bluetooth Sound Printers & Keyboard Trackpad Mouse
Update Scanners

Qg = v = e

Displays Sidecar Battery Date & Time Sharing Time Startup '
Machine Disk
[ Click the lock to make changes. ?

d. Enable Internet connection sharing :
Click “System Preferences” > "Sharing”. Set the “Share Your Connection From” to the
network you are using (Wi-Fi or Ethernet) then select the port to use. Click “Start” on the
pop-up message to enable sharing.

i System Preferences

[} < H - Sharing Q_ search
a - Computer Name: | |
Computers an your local network can access your computer at:
Apple ID Family Edit...
Sharing SoyoMacBook-Pro.local

= PR— | on  Service Internet Sharing: Off

| Intenet. Computers connected to AC power won't sleep while Internet
General  Desktop&  Dock & Mission siri Spotlight  Language  Notifications | File Sharing Sharing is turned on.

ST, S Y e Macta sharing e g —

o — | printer Sharing

~ § | "

5= M & @ Remote Login P,
Ul ‘ N - | gi To COMPULETS USING: 1 ports

Remote Management
internet  Wallet&  TouchD  Users&  Accessibilty ScreenTime Extensions  Security |
Accounts  Apple Pay Groups &Privacy Remote Apple Events

USB 10/100/1000 LAN

@ 0 = 5 Content Caching
d e |
1 | |
- |
Software Network Bluetooth Sound Printers & Keyboard Trackpad Mouse
Update Scanners
. !
[==] - O @ (& |
iz . o |
Displays Sidecar Battery  Date &Time | Sharing Time Startup. |
Machine Disk N

Thunderbolt Bridge
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Are you sure you want to turn on
Internet sharing?

If your computer is connected to a
network, turning on Internet sharing may
rk settings of other
computers and disrupt the network.
act your system administrator
before turing on Internet sharing.

LX) < > i Sharing Q search
Computer Name: | )
‘'soyoMacBook-Pro.local : Edit..
On  Service @ Internet Sharing: On

Screen Sharing letarmet

File Sharing Sharing I turned on.

Media Sharing Share your connection from: /1 o

printer Sharing

Remote Login To computers using: ;...

Remote Management

Remote Apple Events Thunderbolt Bridge

@ _ Bluetooth Sharing

Content Caching

Bluetooth PAN
¥ USB10/100/1000 LAN

e. Set the IP address of your computer to 192.168.2.1:
Click the network icon in the upper right corner and select “Network Preferences”. Select
the right interface (RJ45 adapter). For “Configure IPv4”, select “Using DHCP with manual
address” from the drop-down list and set the “IPv4 address” to 192.168.2.1.

= 4% & Q 8 =%

Thu Aug 19 14

®o o < > EE Network
ication:  Automatic
= WiFi _
= @ Comnected Status:

Bluetooth PAN
@ Not Connected

Configure IPvd:

%Y Thunderbolt Bridge
® ot Connected

DNS Server:

Search Domains:

+[-e]

Q seare

Cable Unplugged

Either the cable for USB 10/100/1000 LAN is
not plugged in or the device at the other end is
not responding.

off

Advanced... | 2

Revert  Apply

eeo < >

i Network
Location: ~Automatic

Wi-Fi
= @ Connected Status:

Bluetooth PAN
@ Not Connected

Q seareh

Cable Unplugged

Either the cable for USB 10/100/1000 LAN is
ot plugged in or the device at the other end is
not responding.

¥ USB10/1..1000 LAN
Not Connected

Configure IPva:
() Thunderbolt Bridge

1P Address:

Using DHCP with manual address

192.168.2.1

@ Not Connected s

Router:
DNS Server:

Search Domains:

Advanced... | ?

Revert

f. Select the software interface display language :
Use the drop-down list to select the language and then click “Next”.

g. Log in to your member account :

Log in to benefit from added functionality and improvements of software updates.
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| CH 2-5 Connection Settings

h. Select the connection method :
Select “Direct Connection”.

i. Enter the IP address :
Enter the IP address of the machine to complete the setup process. The IP address usually
starts with 192.168. (If it starts with 169.254, it means the computer may be set up incorrect-
ly or the network cable needs to unplugged and plugged in again).

Return to the setup connection method screen at any time via “Machines” >
“Machine Setup” in the menu.

[Troubleshooting] Connection Issue ( p.211)

Once the Connection is Complete,
You Can Start Your First Engraving!
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CH 2-6
Beam Studio
Tutorial

Including Camera Calibration, Engraving
Material Focusing, and Common Software
Functions.



| CH 2-6 Beam Studio Tutorial

1. Automated Error Reporting :
If you encounter an error alert window, click “Yes” to agree to automatically upload the
information to the development team. This will help the team identify potential software
problems.
Note: Customer support may still request you send the relevant bug report.

Let's make Beam Studio better
together

Do you agree to automatically upload relevant information
to the development team when errors occur?

Yes No

2. Camera Calibration :
To ensure accurate engraving, calibrate the camera and engraving position.
Required Iltems : A4 (Letter size) white paper
Note : 1. Camera calibration is required before using the camera preview function for the
first time. 2. Refocus the platform each time to get the best results.

WELCOME

Please calibrate the camera when using the machine for
the first time. (Menu > Machine > [Your Machine] >
Calibrate Camera) And refocus the platform properly every
time before preview to get a better preview result.

Yes No
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a. Select Device : Select the name of the machine in use. The machine name can be verified
on the machine page interface.

Select Device

B [Danny] Idle (wiF)
Fortuna_B Idle (wiF1)
Fortuna_C Idle

Cancel

b. Place paper : Place a clean sheet of A4 (Letter size) white paper at the top-left corner of
the working area.

Camera Calibration

Please place an A4 or Letter size white paper at left-top corner of
workarea

A4 cretersize)

CANCEL
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| CH 2-6 Beam Studio Tutorial

c. Focusing : Double click the height adjustment button to raise the honeycomb table up
until the probe touches the paper.

Camera Calibration

Double click the height adjustment button to rise the honeycomb
table up and make the probe touch the engraving material.

d. Draw calibration image : The machine will cut out grid lines on the paper.

Camera Calibration

Double click the height adjustment button to rise the honeycomb
table up and make the probe touch the engraving material.

Drawing calibration image...
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e . Place the red square : Click anywhere to cancel the prompt and move the grid lines to the
center. Align the outside of the red square with the center square by adjusting the horizontal
and vertical translation, rotation angle, and size ratio (you can use the arrow keys to adjust
the values).

Camera Calibration Use these parameters to adjust the red square

Please align the outside of the red square with the cut square. |

vheso 1007

[ Show Last Result

e-1. Red square adjustment completion position.

Camera Calibration

Rotation 0.1

XRatio 994 %

Y Ratio | 987 %%

[7) Show Last Result

CANCEL BACK
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| CH 2-6 Beam Studio Tutorial

f. Camera Calibration completed : Once the camera calibration is completed, you can begin
engraving.

Camera Calibration

Calibration done. Better camera accurency is given when focus
precisely.

DONE
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3. Beam Studio Tutorial : After completing the Beam Studio tutorial, you will know how to

carve round and square shapes out of wood.

Required Items : Engraving Material: 3mm wood piece (included in the accessory box).
Note - To ensure the best engraving results, make sure to follow these steps:

1. Engrave before cutting : work from the top to the bottom of the layer. Make sure the
engraving layer is on top and the cutting layer is on the bottom. Doing so avoids collapse
of the object after cutting.

2. Cut inner objects before outer ones : If there are multiple cutting objects in the same
layer, cut the inner objects first, and then the outer objects. For e.g., if object a is in object
b, then cut object a before cutting object b.

I
O
O
O First cut the inner object a
) J
L Then|cut the outer object b
Steps :

0. Select "Yes" if you would like to start the Beam Studio tutorial.

1.

Switch to Preview Mode : Tap the Camera Preview icon on the left then select the machine
in use.

. Preview the Platform :

a. Place the wood piece on the platform

b. Adjust the focus

c. Close the cover

d. Preview the range of engraving material by clicking on the working interface or selecting
a preview range

. End Preview Mode : Select "End Preview” '3 °

. Draw a Rectangle : Select a “Rectangle (M) ” O to draw a square in Layer 1. Press Shift

to to make a square.

. Drag to Draw : Drag to draw a square on the working interface.
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| CH 2-6 Beam Studio Tutorial

6. Switch to Layer Panel : Switch to the layer \’/ panel to set the parameters.
7. Set Preset : Wood - Cutting : “Wood - 3mm Cutting”.
8. Add a New Layer : Name the new layer Layer 2.

9. Draw a Circle : Select “Oval (L)” O to draw a circle in layer 2 . Press Shift to make a
circle.

10. Drag to Draw : Drag to draw a circle in the working interface.
11. Turn on Infill : Turn on the infill function.  Infill [ @)
12. Switch to Layer Panel : Switch to the layer & panel to set the parameters.

13. Set Preset : Wood - Engraving : “Wood - Engraving”.

14. Send the File u :

a. Confirm the parameters and layer settings.
b. Select the name of the machine in use.
c. Click “Start” to start the engraving and cutting process.

[Troubleshooting] “Cooler Off” (p.185), “Door Opened” (p.187), “Homing Failed”(p.191), etc.

- *Return to the Beam Studio tutorial at any time by selecting “Help” > “Show
Start Tutorial”.

- If the engraving is blurred or the color is light, please check the focus first. If
that does not fix the issue, inspect or adjust the optical path. See [Maintenance]
“Optical Path Inspection” (p.144), “Optical Path Alignment” (p.146).
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CH3S3

Software
Operation



CH 3-1
Software
Interface

This chapter introduces the software
features and demonstrates the 4 creation
technigues, including Beam Studio
creation, importing work files, Trace
Image, as well as mass production, and
concludes with formatting instructions.
Available for Beam Studio 1.9.X.






The software interface can be divided into 5 sections

A:
B
C:
D
E

070

Toolbar

: Layer and object management

Parameter Settings

: Menu

: Working Interface

@ BeamStudio File Edit View Machines Window Help

( O]

70 004A0NHK Y

v,

1BQe=E0*w @



| CH 3-1Software Interface

68% (@ Q & FriSep 24 17:07:40 |~ |l

Parameter Settings (Layer 1)

o o]
Custom v +
Power 15
Speed 20 C

Execute

071



[44¢]

"){se} Y3 J9AI|9p pue dSh U] dUIYdeW 3y} JO SWeu ay} 309|9S

}se] 8yl BUIPUSS 840480 Yled BUIMIOM UOIIRINWIS 38Ul MBIASId : MAIAdAd Y1OM

'syjed aul| meiq

aum N\

*(3nejop Aq 9|eds) A|oa4y sa|l
Joduii i3snfpy awi} e je 1x33} 40 123[qo Buimelp
9UOo 9|eds pue ‘saalbap S (so)1 Buipiodwi

1d9ox9) S1x9) pue s323[qo Buimelp djel}04 0} dqV
‘(1) 1eAO pue (W)

9|6ur}d9Yy WL} S3|2412 pue saienbs melp 03 3|1qy
! JIYys pieoqgAa) ay} pjoy pue ssaid

‘'sasdi|je melq

‘Buimedp ajiym pieoghsx syl
JO SAaY .-, pue  +, 8yl Buisn Ag pasesldap JO pasealdul
90 UPD S82I18A UOBA|Od JO Jaguunu 8y ‘SUOBA|od meuq

(1 1er0 O

uobAjod O

'PIIOS B0 ||IM X3 ‘U0
"SNIPEJ SJBUI0D PBPUNOJ SI 31 92UO ‘930415 1X8]} B AJUO SI 9493 ‘U0
a|ge1snipe 03 8|qy ‘Se|Bueldal meiq 10U SI [[1JU] 81 UBYAA 'SIX] MBU PPY
(W) a|Bueday _H_ Wwawar |
' N\

ebeuwl AdoD),, Ja1je J8SMOIg By WO} A|30a41p Way)
21sed JO aJ1em1jos ayj Ojul A30adip wayl dodp pue Belp
pue sslly 4dd / IV / 4XA / OAS / ONd / Odr Hodu] 's308[qo diy108ds 109|893

mesew; 9 (W Paes 4

jeq|oo] : Vv



.0

P
‘Pal1s|ep 89 10U ||IM ebeuwl| 8del] 8yl JO S308(qo
2y} Ing ‘edewied ayy AQ peamalrsld sebewl syl 918|ep Ued NOA |E|
I M3IA3Ud 13D
‘MalABId elawled eIA
Bullpa 24eM1JOS 40 SOIdYeIB J0JOBA 0 UJdalied e 1J8AUOD pue ueds M’.u
: 9bew| 9deI]
‘PaAeIBbUS 8Q 0] S|elialeul ay) JO UoI3ed0| 8yl malraid 03
abuel e 109|8S JO XDI|D ‘S|eltaiewd BulAelbus JO sbuel syl M3IASId a+
I M3IABId eldWERD
uoljdung MaljAaid eldwed e
-
4
‘|eD1IIBUWIWIAS S|
abueyd ay) pue ‘ebueyd [|IMm Julod UoI1D8[8s 8yl JO S8pIS Yjog uo
yied ayj ‘s|puey ayjy JO 9pIs sUO JO Yibus| syl Bulsnipe Uusypn
: AlpwwAs)y °-0-°
"9pIs BUl]|0J3U0D 8y} UO BJoW dbueyd
1M Yied ay3 3ng Juiod uoI309|8s 8y] JO S8pPIS Yy30g Uo abueyd [|IM
yied ayi ‘e|puey ayji JO 9pIS BUO JO Yibua| ayy Buiasnipe usypn
! yjoowsy ol
‘abueyd ||Im 8pIs 18yl uo yied
ay1 AUO ‘s|puey 8yl JO BpIS auOo JO Yibus| ayy Buiasnipe usypa
1 Jauiod] o
: 9dA) @pou ayj 0} Buipi0dde sdpow ¢ die a4dYL
‘Yyied ay3 ype 03 yjed Buimelp uad ayj 2110
a|gno "yjed uad ayj pus 03 0S8 pJeogAey 8yl asn Jo julod pus ay3 %2112 8|gnod
"'SOAIND MEIP 01 8|qY : BulMeJp 8|Iym UolINg asnow 1Js| ayj pjoy pue ssaid
‘Buimelp ysiuly noA usije juiod
Joyoue syl yiim adeys ayj 1snipe pue J0309A 8yl JO SOAIND pue Saul| ay3 auljinQ
ua
(d) uad lﬁ
.

@oeyia3u| asemipos |-s HO |



vL0

*19p40 J2Ae| 8y} 1snipe o} J9Ae| ayj doup pue 6eiq

‘'sJehe| pelos|es ayy 8189ep

0} A8y 9318|9p PJeogAay JO 818|9p »2112-1ybli 8yl asn usyj ‘918ap 03 Juem noA Jake|
33} 109|8S pue JIYS pJeoghsy sy) ssaid : awl} awes ay) je sidhe| ajdiyjnw a3s|eqg
‘(QUOJS Ul jdew an|g e Ag palege)) JeAe| pelos|es

1Se| 8Y3 JO aWweu ayy 8 |[Im audeu JaAe| ay] ‘Bulbieul 4oy : sio9AeT palo9|as abia
JaAe| WO0310Q 8y] JO sweu ay) aq ||IM aueu JaAe| ay) ‘Bulbiau 18V : ||V ©6J9W
J9Ae| 1XauU 8y) JO sueu ay) aq [|IM awleu JaAe| ay] ‘Buibisw 491y : umoq 8649
JaAe| ay) 919ja( : 19AeT 819|9@

JoAe| syl ebisul pue ‘sAOW ‘@18|8p

‘sWweusd Uued NOA 1ng ‘11 BUIMD0| J8}je S303lqo JaAe| ay] 11Pa J0UURD NOA : J18AeT 3207
'doy 3sI| @43 uo JaAe|

MaU e ppe pue JsAe| ay) JO sislawelded pue s108(qo ayj ayedldng : 419Ae ajeaidng

: BUIMO||0) BY] Op 03 8|ge S| UwWnN|od J8Ae| 8yl uo 21|12-3yBIy

ueAe| 8Y3 J4O UINY 03 121D

19Ae1 moys

‘snoJswnu
10 po1ed||dwod aJe sadeys oyl JI poldslie ag Aew paads Bulips pue sduewllojiad
2JeM1JOS By} ‘SIOJ0D JaAe| BulAe|dSIp USUAA ‘SJoAe| juslallip usemiag sidoslqo Jo
JOJ|0D 8y} ysIinBulisip 03 40|00 Jake] asn, < .MaIA, uado Uo|0d ay) Buibueyd Jaiv

10]0D J9Ae"
-
1S1| UMOop doJp ayjy ul JsAe| ulelsd e 03 308[qo pPa3os|es PEVNC]
9] Jajsuedy ued noA ‘suaAe| a|dijnw aJe aJayl Usypa MBU e suleu pue a1eau)
a At
03 SjUSW|d 9AOW Hete 19heq ppv |_l

10} SjUaWale SO

: jJuswabeuew J9AeT

‘MO[8Q se aJe suoioNpoul 84l 'SNOILDYV Pue SNOILdO
a|geisnipe UMo Jlayy aAey Os|e 1ng ‘s31oa(qo Buimelp pue ‘Ixa) ‘ednjold Ag paJeys suoljouny
2yl SJSA0D AJUO J0U jJusWwebeueuwl 308[qO ‘jJusuisbeuew 109[qO pue jususbeueu JshAeT

juswiebeuewl
}09lgo pue 12Ae] : g



S0

4 N N\ 4 N\
Elile}
031Ul solydedf J0308A 'sjoelgo Jaylebo)
pPaso|o a|di}INW auIquoD) padnoJb ayj |aoued s3o08[go s|dnnuw dnoug
uolun ‘ dnoJabun ﬁ dnoig E
\ J J \ J
4 4 N\
‘Aljeyuoziioy
J93U82 ay3 03 s3o8(go 's109[qo a3 Jo Bulpunogq
pP9109|9s a1 ||B ubl|y 1souwlybl ay3 splemol s309qo pa3dsles oy} |je bl
ubly 403usd ubI|v Y61y —
\ \ J
4 N\ 4 N\
‘uonoalIp
'$308[qo 8y) JO BUIPUNOQ 3SOWHS| 8y} |eD138A 8Y3 Ul sydeuB ay3 Jo Jajusd ayj
SpJemo] s109[qo pPo1os|as ayy ||e ubl|y AQ AJuaAs s108[q0 pPa129|as oyl 91ngliisig
usllvy wo1 °INquSI [E21MOA mmm
\ J J
4 N\ 4 N\
'$309[q0 8Y3 JO BUIPUNOQ WO0}30q ‘K||e21149A 9|ppIu
8y} 03 s308lqo pejosles ay (e ublly 8y} 03 s308[qo pe1os|es ey} e ublly
ubly wonea  f ubIlv IPPIW
\ J J
4 N\ 4 N\
"‘UoI08JIp [23UOZIIOY
'$309[jo 8y} Jo Bulpunoq 3U] Ul sydesB oy JO J91usd 8yl Aq
dol 8y} 03 s308[qo pPa3os|es ay} ||e UBlY Alusne s3108[q0 pPa3de|as ayy 8ingliisig
usiiv doy gl 2INqLIISIA [IUOZIIOH _—_
S J - J

'$108[g0 BUIMEBIP pUe IX8] '8JN310Id JOJ SUOIIdUN] paJeys : Judwabeuew 323[q0

@oeyia3u| asemipos |-s HO |




9.0

N\ ' N\
J9UDD

199[00 (J418y3) s) Ybnouyy aull [ed114eA ay)y
0} BuipJodoe (S)3o0alqo paids|as ayy di4

‘Al@al) $308[q0O Pa31d8|8s JO SazIs
CIERERIEPEYY ‘ﬂ 23 @onpaJ Jo abiejus 01 UIYS pJeoq
) -Ao¥ 8y] p|oy pue ssaid : paso|d 3207

'sjoelqo

7 po3108]8s 8] 8|eds 0} PIYS pieoghsy
9Y31 pJ|oy pue ssaud : pauado 32017
»00[ 8Y3 8S0|2 41O Uado 03 %2110

J93u8d 108(
-qo (J18y31) sy ybnodyy aul| [eIuoZIIoY ay)
0} BulpJodoe (s)108lqo pelos|as syl di4

dild [e3uozLIoH M_ wo1 W

N N
Y618y SIS H pue Yyipim

S} SI AN 308[gO ue Jo 9zIs 8yl i1snlpy 'S109[q0 Po3108|9s ay) JO v|bue ay] Isnipy
8z1s 329[q0 000k H oL m s|6uy uonejoy 00
J J
N
1X8] : abues yBIy6IYy ay3 Jo julod 13| do] "UOBA|0d ‘B|buelday ‘sbew|
1 Xoq Buipunoq ayj jo juiod 33| doj ‘sulT : syulodpud om] ‘|eAQ : julod J9judd
'90eJJ2]Ul BUIMIOM BY] UO 21RUIPI00D 1230
ajeulpiood 0 A 0 x
J
N N\
0|02 JsAe| (paxiew
aNn|q) pe128|es 8yl aq [|Im 1dey uiened JO|0D JaAe| (payJeud an|q) pajos|es
81 JO JOJOD 8y} ‘SusAe| JO|0D JUBIBIP 2yl g ||Im 1dex uusiied sayy JO JOJOD By)
OM] UO aJe sadeys J0109A OM] 4| "1doy ade ‘'sioAe| JO|0D JusJBIP OM] UO ade sadeys
solydedb 10309 Paso|d sjdiyinw Jo syied 10308A OM] J| "delusA0 Jey) solydeudnb J03ooA
padde| aAo-un ayjy AJUO ‘UO S| ||IJU] UBYAA pasoo> a|diyInuw Jo jed ayy Auo desy
aduaJayia h 109s49ju| ‘
J - J
N

0|02 JaAe| (payJewl an|q) Pa3os|as 8y} aq ||IM JO|0D 8y} pue JaAe|
Jaddn ayj deay 03 pa3oeligns ag ||IM uisiijed ay) ‘SisAe| JOj0D Juslalip OM) UO aJe sadeys
J0308A OM] 4l ‘ped umelp 3se| ayjy desy 03 peidedigns g ||Im uJdsiled ayy Jske| swes ayj uo
aJe solydesb J0308A OM] 4| "SDlydedB J03D8A Paso|D OM) ay) JO sued Buiddelusno ayj a1sag

1enaqns ‘

J




LLO

+ %08 -

feuy
onu ]
doio uedieus
Bupein o

i soeidey

gk sseuBuq ploysaiy

wipEID

FOBL H 0BT

00 uuggL A

856 X

a

@ +-0O0C/

aBew < | soke

2~ 21800050

+ %08 -

fouy
wanu orog
doiy uedieus
Bupein soeiL

g eoeidey

weipein

FOBL 1 L0BT 1

00 uHggLL AU 8G6 X

=

a

obeuwn % @

2~ 21£000Sa

4 3 +-0O0C0CV/

oBew < | soke

JNOIUOD B3 82UBYUS pUe 8SI0U 8y
Je8[2 01 J9PIIS 8Yl A0 >oe|q 01 MOJaq
pue 811YM 03 POIIBAUOD 8] [|IM GZ| DAOCR
SI0j0D [|e ‘Gzl O3 38S SI P|oysaly} 8yl 4|
'8]Ilym BUIB] GGZ Pue 3oe|q Buled | Yiim
‘GGz 01 | WOJ) 9]eds e uo sjusuodwod
10j0D GOy 8yl Seulsp uonlduUNy SIYL

‘Ployseiyy uoiezieulq ey isnfpe
01 pasn aQ ued ssauYbIIg PloyYsaIy |
81 ‘440 pauJN S| UBIPRID BY1 J| A

‘JInejep Ag Uo pauuny aJe syusipelb
pue a|edsAelf 01 PB1ISAUOD ale sabewll
‘solydelf deuwyig Buiyjodudl Usypa

ssaujybliq pjoysaiyL

(@ ) B

sipelo

aoeyialu| a1emyos 1-s HO |

: SNOILdO



Font Arial Narrow v

Font

Apply any fonts installed in the operating system to a Text.

Style Regular v

Style

as bold, ltalics, etc.

Different font-styles are available with different font installed in the operating system,

Size 100 Size

N

Letter spacing 100

Letter spacing

Set the Text size.

Set the space between letters.

Line spacing 0 Line spacing

N

Vertical text ()

Vertical text

Set the space between adjacent lines
of type.

A\

Vs

Rounded
corner

Rounded corner 0

Round the corners of a Rectangle.

—>

Create vertical scripts.

-------0
B

|

X C

9_
0
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| CH 3-1Software Interface

<
Infill @ Infill
Fill the blank areas of texts or closed vector graphics with color
often used for engraving. F Ll ' X
J
N\
Text Offset 5 Text Offset
Set the start point of the text on the path of “Text on Path”.
J
N
Alignment Middle Align v Alignment
Decide the alignment of the text bounding and the path in the vertical direction of
“Text on Path”.
>
J
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P
Text Infill @  Textinfin

Fill the blank areas of texts of “Text on Path” with color.

.
~

Path Infill @ Pathinfil

Fill the blank areas of paths of “Text on Path” with color.
_
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| CH 3-1 Software Interface

OPTIONS

. 0 image Text  Rectangle  Oval Polygon
e O X X X X
mgmness O X X XX
Cemer XX O X X
Font X O X X X
Style X O X X X
size X O X X X
ey X O X XX
weens X O X XX
e X O x XX
Infill X O O O O
TextOffset X X X X X
Alignment X X X X X
retoit X X X X X
pathinfil X X X X X
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OPTIONS

Tool Multiple

Line Pen (Path) Objects Text on Path

Funtction

Gradient

X
X
X
X

Threshold
brightness

Rounded
corner

Font

Style

*

Size
Letter
spacing

Line
spacing

Vertical
text

X X X X X X X X
X X X X X X X X

Infill

Text Offset

Alighment

X X X X X X X X X X X X
OO0 0O X XX O0O0O0OO xXx x

X X X
X X X

Text Infill

X

X X

Path Infill

. Infill of Pen : When the pen path is a closed vector graphics, Infill function can be
performed.
Infill of Multiple Objects : When the selected objects do not contain an image and
there are more than 2 drawn closed vector graphics, you can select multiple objects
at the same time and perform the Infill function.
Delete Multiple Objects at the same time : Delete after selecting multiple objects.
Path Infill of Text on Path : When the path of Text on Path is a closed vector graphics,
Path Infill can be performed.

* 1 Size of Text on Path : The size of text of Text on Path can only adjusted by setting a

082 size value but not dragging the control points on corners of the text bounding.



| CH 3-1Software Interface

ACTIONS :
e N\
Replace With... 1 ( Trace
Change an image to a new selected Convert a binary image to a vector
image from the computer file. path. The more complex the pattern,
the longer the conversion time.
N\ J
e N
Grading Crop Sharpen
Adjust image brightness Remove unwanted Sharpness : Enhance
and contrast. Tap the content. Drag any edge the edge contrast of an
middle of a line segment of the crop box to image in an attempt to
to create an adjustment adjust its size. improve its acutance.
point. Radius : If Sharpness
has a value, you can
Curve move the slider to
remove noises.
Sharpen
Sharpness [ ] 0
Radius [ ] 1
N\ J
e N
Convert to Path Decompose
Convert a Text to paths Discontinuous paths are “single” paths made up of a
for editing. Pen, or several closed vector graphics being processed
by Union, Subtract, Intersect, or Difference. Decompose
is to dissolve a single discontinuous path into multiple
paths.
- J
e N
Invert
Reverse the color of an image, such as negative effect. When engraving transparent
materials (such as acrylic), Invert is usually needed to be turned on.
N\ J
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Bevel

Create a blurred grayscale gradient for edges of bitmap graphics. Bevel is
often used to smooth out engraving depth differences.

Array

P
Offset

Copy a large number of objects. The
number of rows (horizontal direction),
the number of columns (vertical
direction), and the object spacing (The
spacing is the distance between centers
of two objects.

distance inward or outward.

Create concentric objects at a custom

Create Grid Array Offset
Array Dimension 1X1 Offset Direction Outward
Cols. 1 Outward v
Rows | 1 Corner Sharp
Array Interval 0,0 mm Sharp v
X | 0.00 m Offset Distance 5 mm
Y | 0.00 mm 5.00 mm

N N\

P

Edit Path

Edit the path or adjust the node type.

Create Text on Path

Put a text design along a path.

Decompose Text on Path

Decompose a Text on Path into a Text and a Path.

084




| CH 3-1 Software Interface

ACTIONS
ol mage Text  Rectangle  Oval Polygon

e O X X XX
Trace X X X X
S © X X X
sharpen () X X X X
Crop O X X X X

Bevet (O X X X X
et O X X X X
amay (O O O O O
Ww X O O O O
offset X X O O O
Decompose X X X X X
Editpath X X X X X
Tomm XX X XX

X
X
X
X
X

Text on Path

: Trace of Image : Only binary images can be converted to vector paths (one at a time).
Grayscale images are not allowed to do Trace.
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ACTIONS

Tool Multiple

Line Pen (Path) Objects Text on Path

Funtction

Replace
With...

X

Trace
Grading
Sharpen

Crop

Bevel

Invert

Array

X O X X X X X

Convert
to Path

Offset

Decompose

X X

Edit Path

Create Text
on Path

X X X O 0O O X X X X X X X
X O 0O O X O X X X X X x X
X O X X O 0O X X X X X X X

Decompose
Text on Path X X X O

: Offset of Multiple Objects : \When the selected objects do not contain an image or a
Text, and there are more than 2 drawn objects, you can select multiple objects at the
same time and perform the Offset function.

Text on Path of Multiple Objects : When a text and a path, Image or Text excluded,
are selected at the same time, Create Text on Path can be performed.
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| CH 3-1Software Interface

C : Parameter Settings

D Import Db Export

Select

Custom parameters

Import all engraving
parameters stored
ina json file into
the parameter list.

Export all parameters
as a single .json file.

The suggested parame-
ters for common mate-
rials can be found in the
drop-down list.

Q Manage

-|- Add current parameters

Browse all parameters, and edit or de-
lete customized parameters.

“Z STEP (mm)” : When performing mul-
tiple cuts of the same path for a single
layer ("EXECUTE” > 1), you can set the
descending amount of the laser head for
each execution to cut thicker materials.
This setting is only available for autofo-
cus add-on.

Name the current parameter and save it
to the parameter list.

Power (%) : the percentage of laser
output power.

Speed (mm/s) : the number of millime-
ters per second the laser head moves.
Execute (times) : the number of times
a single layer is executed for the same
job.

Since there are various materials, for the first time, you can choose the built-
in parameters to observe the engraving results and then fine-tune them to
achieve the desired effect.
It is recommended that the power setting be less than 70% to reduce laser

tube consumption.

The decline of laser tube caused by usage and time is normal, and the param-
eters should be adjusted according to the situation.
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D : Working Interface

The center of the window is the area for importing images or drawing objects. Note that
objects should be placed in the area to proceed the task.

‘ — 100% + Zoom in or zoom out the working interface

E : Menu

The menu will explain the frequently used functions in each tab.

.’ Beam Studio File Edit View Machines Window Help

Beam Studio - About Beam Studio, Preferences ...

Preferences : Modify default settings such as language, machine IP address, and
add-on.

File - Open, Save, Save As, Examples, Export To ...

Examples : Use examples, including different files and material engraving tests (differ-
ent power speed combinations to find out the suitable parameters for new materials).
Export : Export files to several formats, including BVG, SVG, PNG, JPG, FLUX task. De-
tailed information is explained in this chapter on file formats.

Edit - Optimize, Document Settings, Clear Scene ...

Optimize : Optimize the object arrangement, so that the engraving material can be
used more effectively.

Document Settings : Adjust the engraving resolution, working area (select the model),
and add-on switch.
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| CH 3-1Software Interface

<
View - Show Grids, Use Layer Color ...
Show Grids : Display the grids in the working interface.
Use Layer Color : Show the layer color on objects in that layer.
J
N
Machines - Test Network Settings, Calibrate Camera for machines connected to this
network, Update Firmware ...
Test Network Settings : Check the quality of the network connection between the
computer and the target machine.
Update Firmware : Download the firmware from the official website and save it on the
computer, then change the machine firmware to the selected version by selecting the
firmware file on the computer. Note: It takes a few minutes to upgrade the firmware,
so do not turn off the machine in the middle of the process.
J
N\
Window
This is the default menu for Mac systems; Windows and Linux Ubuntu do not have this
option.
J
N
Help - Show Start Tutorials, Bug Report, Debug Tool ...
Bug Report : Export a bug report after an error is encountered. Please mind that the
software cannot be reorganized or shut down before exporting a bug report. Customer
Service guides the export of bug report files to troubleshoot Beam Studio errors.
Debug Tool : An interface for developers to debug software issues.
J
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CH 3-2
Four Creation
Techniques

This section contains Beam Studio
creation, Import Image, Smart Trace, and
mass production operation steps.






Beam Studio is designed for FLUX laser engraving machines, which can effectively
interface with other professional design software

(see Appendix Il 2-1 Design Software Recommendations) for laser engraving; if there
are more complex objects and shapes to be engraved, it is recommended to use the
method of Import Image, and after importing the drawings, final layout and param-
eter settings are made in Beam Studio.

Beam Studio Draw
creation | objects I

Set layers

First editing of mass 1 |
production project

(A fixture is needed for
fixing the material positon)

Import Adjust parameters
Image (Threshold)
Import Image |

(as Al or SVG) J_ I

First use the
camera preview
function, and then
Trace Image

Place artworks

Smart Trace in the working
| area
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| CH 3-2 Four Creation Techniques

When previewing the Smart Trace image, make sure the least amount of preview is
done to avoid the misalignment of the image caused by stitching. If the tracing image
is small, you can click the center of the image to place it in one camera preview screen

when previewing.

After confirming the position of the fixture and objects in the first editing of mass
production project, FLUX task can be exported to the USB flash drive. In the future,
you only need to insert the USB flash drive into the machine, focus on the engraving
material on the fixture, and then click "START" page to select the file and directly start

the engraving job.

First
Place the ::fng::
Set the engraving review
parame- = material - ?unction
ters and adjust i
and then
the focus Trace
Image

-

Deliver

the task

Export To
FLUX task

Save the file in
a USB flash drive

Plug the USB flash
drive into a USB port
in the back of the
machine

Get into the
"START" page for
the saved file
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CH 3-3
File Formats

There are two main types of digital
iImage files, bitmap files and vector files.



1 Bitmap
Graphics

Bitmap is an image type that consist of
numerous square pixels. Bitmap files are
rich in details which are mostly suitable
for photography or digital applications.
However, the quality is related to the
resolution so the image can get jagged
or blurry when resized.

| CH 3-3 File Formats

2 Vector
Graphics

Vector images are composed of paths
defined by multiple points and are es-
pecially suitable for logos and font lay-
out. For each path, curve, or shape has
its own formula, and can therefore be
resized without affecting the graphic
quality.

Suitable for infill engraving

Suitable for outline engraving and
cutting

Long working time

Short working time

Complete image quality

Clear contour

JPG / PNG are commonly used bitmap
format

Al / PDF / SVG are commonly used
vector format

It is essential to use the vector format when cutting. The next page will
contain a table explaining the file type of import image and the file type

of saving, etc. There is also an overview of the layer layering method and
the engraving resolution.




File import and export formats :

File type of
import image
Content
Layer
Layering
Style Color
Single
Layer

Scale Setting

Vector Bitmap

Gradient
Options

Threshold
brightness

Saving
Condition

Export To

Save As

BVG

as the
original
file
settings

X
O

as the
editing
condition

SVG PNG JPG DXF Al

O

O
O
X

O XOX0OOX
o | O
o O X

X X X X
X X X X
O O X X

O X O 0O X

separate

vectors

and

bitmaps | Bitmap | Bitmap N/A N/A
into

different

layers

BVG / SVG / PNG / JPG / FLUX task *

.beam

O X O 0O X

N/A

bvg / FLUX file (.fc) / .beam is a special file format saved by Beam Studio. If a file contains a
bitmap, the software will export it to the bitmap preview quality in a .bvg file, while saving it
as a .beam file will preserve the original image resolution.

*FLUX work : fc file. .fc file is a machine-readable file that saves the software values as object
layout, power, etc. This file format cannot be reimported into Beam Studio for editing and is
often used for mass production work using fixture positioning.
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| CH 3-3 File Formats

File type of reimport file

Parameter

Settings O

(Power, Speed)

Things kept FLUX
after import = SuE PLie JPG task* -beam
Bitmaps of
original X X X X X O
resolutions
obet O | O X X X O
Object size O O O O X O
Layer Settings O ) 4 X X X O
X X X X

O

Layering : You can set the layering style by “Layer”, “Color”, or “Single Layer” when importing

SVG files in Beam Studio.

1. Layer : If you have set up layers in external software, you can choose this layering
method.

2. Color : If there are objects of different colors in the file, you can choose this layering method,
and the software will create layers according to different colors.

3. Single Layer : If there is no need to set different power and speed, you can choose Single
Layer, and the software will merge all layers into a single layer.

Engraving Resolution : In Beam Studio, you can set the engraving resolution, i.e., engrav-
ing fineness, from low to high, at 100, 250, 500 and 1000 DPI by menu > Edit > Document
Settings. High resolution engraving result can show more details but take longer time, on
the contrary, low resolution engraving result is simpler but takes less time to complete. It is
recommended to choose the suitable engraving resolution according to the creation needs
and time consideration.
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CH 4-1
New Materials
Testing



| CH 4-1 New Materials Testing

Beam Studio  File Edit View Machines Window Help Try different combinations of speed
Open (S: Speed) and power (P: Power)

Open Recent > to find appropriate parameters
D) Save %S for materials you have not worked
. SR e | with before. Sample test files can
(o] = . B .
Examples )‘ Example of beamo be imported through “Menu > File >
< B T 5 Xm'f beab . Samples > Material Engraving Test.
. /o Erorevina Test | iRl : Test files are available for both
1 Material Engraving Test - Classic

engraving and cutting.

Material Cutting Test

Material Cutting Test - Simple
Material Line Test

Acrylic Focus Probe - 3mm

- b S

o > il

Use of the engraving or cutting sample file is not recommended with thin
material (thickness less than 0.5 mm) due to the potential for excessive
burning resulting in oversized engraving or cutting openings; begin manual
testing of such materials with high speed and low power (e.g., P:15, S:300).
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CH 4-2
Material
Characteristics

In this chapter, we describe the characteris-
tics, advantages, and disadvantages (and cor-
responding potential workarounds) of 8 types
of materials and include a comparison of ma-
terials of equal thickness.



| CH 4-2 Material Characteristics

1. Wood - Fiberboard, also known as medium density fiberboard (MDF)

Glued and pressed wood fiber

Material Suitability
New Zealand MDF O
Advantages Disadvantages

1. Good material stability, easy to cut
2. Low level of surface embossing
impurities

Lower density than
Asian dense board

Note

To reduce the risk of health hazards, use low formaldehyde

fiberboard

Material Suitability
Asia MDF A
Advantages Disadvantages
1. Suitable only for engraving, not easy to cut
Low price 2. Engraving produces a relatively highlevel of
black dust
Note

To reduce the risk of health hazards, use low formaldehyde
fiberboard.

Photo

Photo
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1. Wood - Plywood

Overall: Exterior : solid wood / Interior: glued and pressed wood fiber.

Material Suitability
Teak plywood O
Advantages Disadvantages
Beautiful engineered material Cutting requires higher power
Note

To reduce the risk of health hazards, use low formaldehyde

fiberboard
Material Suitability
Poplar plywood O
Advantages Disadvantages

1. Resistant to cracking and warping,
fine grain, easy to work with

2. Light white, straight grain

3. Light-weight material, suitable for
crafts and as children’s toys

4. Engraves easily with even color
after engraving, edges are not
easily scorched or broken

Engraving results are
slightly blurry due to
lower material density

Note

To reduce the risk of health hazards, use low formaldehyde
fiberboard.
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| CH 4-2 Material Characteristics

Material Suitability Photo

Basswood plywood O
Advantages Disadvantages

1. Resistant to cracking and warping,

tough, fine grain, easy to work with Engraving results are
2. Creamy white, fine and straight grain slightly blurry due to
3. Smooth surface obtainable by sanding, lower material density

staining, and polishing

Note

To reduce the risk of health hazards, use low formaldehyde

fiberboard
Material Suitability Photo
Plain plywood O
Advantages Disadvantages

1. More complex material, harder
texture, less likely to split when
cut

2. Used for building construction
or crafts

Texture quality is poor,
slightly rough

Note

To reduce the risk of health hazards, use low formaldehyde
fiberboard
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Material Suitability Photo

Walnut plywood O

Advantages Disadvantages

1. Resistant to cracking and warping,
tough, fine grain, easy to work with

2. Coffee color, fine and straight grain of Dark wood color

different shades. Z;?:ftslgzsg;awzgent
3. Smooth surface obtainable by sanding, PP

staining, and polishing

Note

To reduce the risk of health hazards, use low formaldehyde
fiberboard

1. Wood - Solid Wood

Natural, healthy, non-toxic, eco-friendly.

Material Suitability Photo
Solid wood O
Advantages Disadvantages ]
!
Naturally varying Depth of engraving may be L
grain characteristics uneven due to growth rings e ————
Note

Growth rings are naturally uneven in wood density
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& Common Problems with Wood :

Problem

Uneven

Engraving
Burn Marks

Cutting
Burn Marks

Solution

1. To deepen the color:
lower the speed

2. To deepen the cutting depth :
increase the power

Before processing

1. Cover the surface of the engraving
material with paper tape

2. Slightly moisten the wood

After processing

1. Remove the burn marks with
sandpaper

1. Use lower-density wood
2. Clean with a small amount of
alcohol

2. Leather - Synthetic Leather

| CH 4-2 Material Characteristics

Possible Drawback

1. Larger burn marks
2. Decreased precision and
distorted proportions

Before processing

1. Tape residue

2. Bumps on the surface
After processing

1. Scratch marks

1. Moisture may warp the wood
2. Excessive alcohol causestar to
penetrate into the wood

Base layer: mostly woven fabric; adhesive layer; resin layer : PU and PVC, etc.

Material

Polyurethane (PU)

1. Base cloth:

Advantages

PU looks much thicker than

PVC from the side
2. Texture: PU feels softer than PVC

Note

Incomplete burning will produce toxic fumes

Suitability

Disadvantages

Photo
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Material

Polyvinyl chloride (PVC)

Suitability

X

Advantages Disadvantages

Engraving produces corrosive
- gas which causes the screws in
the machine to rust

Note

Hazardous materials

2. Leather - Genuine Leather

Supple, soft, malleable

Material

Vegetable tanned leather

Advantages

Natural color, absorbs oil, moist, firm

Note

108
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O

Disadvantages

Photo

Photo




| CH 4-2 Material Characteristics

Material Suitability Photo

Chrome tanned leather ><

Advantages Disadvantages

Malleable, water and stain resistant,

does not easily fade

Note

Burning produces toxic gas, not suitable for laser processing

&\ Common Problems with Leather

Problem

Scorching and
curling

Heavy smell
from laser

Solution Possible Drawback

Wet the whole piece of

. Leather wrinkles after drying
leather before processing

Use air purifier in work Air filter foam sheet is consumable
space
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3. Acrylic - Acrylic, also known as polymethyl methacrylate (PMMA), plexiglass

Strong, tough, durable

Advantages

Material

Acrylic

Produces dust during

No burn marks

processing

Note

Disadvantages

Suitability Photo

O

Make sure that the material is not plastic (PVC, PC)

/N Common Problems with Acrylic

Scratches

Cloudyiness

Explosive
sounds when
cut

110

After processing
Use plastic-specific abrasive
to remove

1. Keep the protective film on
when not engraving gradient
images

2. Clean with a small amount
of alcohol

Some acrylics contain high
levels of impurities; use better
quality acrylics.

May only be able to remove shallow
scratches

Using too much alcohol with some
acrylics may cause surface defects,
such as cracks. But gently heating
acrylic in an oven may help repair
minor cracks.

Big price difference between highest-
and lower-grade acrylics.



| CH 4-2 Material Characteristics

4. Paper - White Paper
Widely available

Material Suitability Photo

White paper O

Advantages Disadvantages

Warps when burnt at high
Widely available temperature; make sure the
position of the paper is fixed

Note \

4. Paper - Corrugated Cardboard

Cheap, structurally strong, suitable for three-dimensional art pieces

Material Suitability Photo
Corrugated cardboard O
Advantages Disadvantages

Easy to obtain, does not require
high power to process, suitable
for structural works

Uneven surface, make sure
focus is accurate

Note

Higher power settings may cause fire hazard

m



&\ Common Problems with Paper

Yellowish o
carbonized material.
burn edges

residue.
corrugated

cardboard

burns
5. Glass
Material
Glass
Advantages

Easy to obtain, e.g.
beverage bottles

Before processing
Paper material impacts the amount and
color of the ashes; use paper with PP

After processing
Use low-viscosity material such as
multi-purpose putty to remove the

Before processing
Slightly moisten the corrugated

Suitability

O

Disadvantages

Chips easily during processing,
engraving results may vary
depending on glass material

Note

1. For your safety, clean engraved glass with a brush instead

of with bare hands

2. Leaded glass is not suitable for laser processing because

glass may shatter

12

Cardboard deforms
more easily (surface is
uneven)
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| CH 4-2 Material Characteristics

&) common Problems with Glass

Laser processing of some glass materials
will result in cracking. This is due to mate-
rial characteristics and cannot be avoided

1. Choose thicker glass

Crackin 2. Reduce power

6. Metal - Anodized Aluminum Alloy Surface

Wear-resistant and textured

Material Suitability Photo
Anodized aluminum alloy O
Advantages Disadvantages

Using too much power may
produce blurry image or
brown color

Obvious engraving effect with
low power; no loss of color

Note
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6. Metal - Spray - Coated Stainless Steell

Material Suitability
Spray-coated stainless steel O
Advantages Disadvantages

Evenly applied spray-coating
makes it easy to engrave
stainless steel

The engraving result is not
sharp and is only suitable for
artwork and experimentation

Caution

1. Oxidize the stainless steel with FLUX Steel Engraving Spray

before engraving

2 . Wear gloves when using the spray to avoid staining the skin

7. Other Engravable Materials - Stone

Photo

There are differences between artificial materials and natural materials, and textures vary.

Material

Stone

Advantages

Suitability for engraving
depend on exact stone, shale
and marble are more suitable

14

Suitability

O

Disadvantages

Engraving effect is usually not
apparent on lighter-colored stone

Note

Photo




| CH 4-2 Material Characteristics

7. Other Engravable Materials - Cement

Material Suitability Photo
Cement O
Advantages Disadvantages
Textures can be easily created Particle size of cements will affect
on the cement surface the overall engraving result
Note

7. Other Engravable Materials - EVA Foam
Lightweight and low density, commonly used in molds and cushioning materials

Material Suitability Photo
EVA foam O
Advantages Disadvantages
Can be cut at extremely low Due to flammability and pungent
power, low chance of burn odor, good ventilation is required
marks while engraving
Note

15



7. Other Engravable Materials - Cotton and Linen Fabrics

Material Suitability
Cotton and linen fabrics O

Advantages Disadvantages

Due to flammability and pungent
odor, good ventilation is required
while engraving

Can be engraved at
low power

Caution

7. Other Engravable Materials - Silicone

Material Suitability

Silicone

Advantages Disadvantages

Instantly hardens when heated, and
therefore not suitable for cutting;
cut with scissors or blades

Eco-friendly,
non-toxic

Note

Reflective mirrors must be cleaned more frequently to prevent
dust from sticking to the mirrors and affecting the laser output

116
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& Common Problems with Silicone

Problem Solution Possible Drawback

Engraving is

. Increase power and Image quality may be poorer
not visible repeat engraving
Cut with other tools, e.g., Cuts may be Uneven
Incomplete cut scissors, utility knife Y

Silicone is dusty

X Clean with a toothbrush
after engraving

Wear and tear of toothbrush

8. Hazardous Materials - Polyvinyl Chloride (PVC)

Usually appears as stickers, thin films, or transparent sheets

Material Suitability Photo
Polyvinyl chloride (PVC) X
Advantages Disadvantages
Jagged melting marks on edges 3
Note PVC/V

Burning generates carcinogens and corrosive gases
hazardous to health
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8. Hazardous Materials - Acrylonitrile Butadiene Styrene (ABS)

Material Suitability Photo

Acrylonitrile butadiene X
styrene (ABS)

Advantages Disadvantages

BT

OTHER

Note

Carcinogenic substances may be generated when
incompletely burned

8. Hazardous Materials - Plastics with Chlorine, Benzene, Ammonia, Fluorine, Phenol, or
Aldehyde in its Scientific Name or with a Hexagonal Benzene Ring in its Molecular

Formula

Material Suitability Photo

Plastics with chlorine, benzene, ammonia,

fluorine, phenol, or aldehyde in its scien- X
tific name or with a hexagonal benzene

ring in its molecular formula

Advantages Disadvantages

Note

Burning will likely generate carcinogenic and toxic substances

Examples of unsuitable resins :

Hexagonal
Benzene Ring

N BN BN O

PETE PVCHV OTHER
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& Non-material-specific Problems

Problem

Laser reflects off
material, e.g. glossy
metals

Laser penetrates
material and reflects off
the honeycomb table

Material Comparison Table

Materials are of

equal thickness Wood
Processing difficulty Easy
Strength of smell Medium

Dustiness Medium

Amount of tar High

Gradient effect O

* metallic dusty smell

Solution

| CH 4-2 Material Characteristics

Avoid using, except for spray oxidized

stainless steel

Elevate the material away from
the honeycomb table to avoid
burn marks on the material from

laser reflections

Leather

Medium

Strong

Medium

Medium

Acrylic
Easy

Strong
High

Low

O

Paper

Easy

Weak

High

Low

Possible Drawback

Glass

Difficult

None

Low

None

Metal

Difficult

*Weak

Low

None

The above comparisons are based on common materials.

Testing on your specific material may yield different results.
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CH 5-1
Maintenance

To facilitate maintenance and repair instruc-
tions, this section divides the machine into
three general areas: the panel, the working
area, and the back cover.



| CH 5-1 Maintenance

Maintenance of the machine according to the maintenance frequency can effectively reduce

the chance of failure.

[Appendix 3] Maintenance Checklist (p.245) provides maintenance record sheet for users

p.129 Screen cleaning

to use.
Area
p.125
Panel
p.131
p.134
Working
Area p.136
p.138
p.144
p.146
p.159
p.161
Back 171
Cover
p.178

Maintenance Content

MAINTENANCE page*

Lubricatingt*

- Wood, Plywood

- Acrylic

- Leather

Chassis cleaning*

Mirrors and lens cleaning*

Optical path inspection*

Optical path alignment

Door cover cleaning

Laser tube replacement

Water changing and adding* ---

Ventilation fan cleaning

* : Necessary maintenance

Maintenance Frequency

Once every 1 month

Once every 2 weeks

Once every 2 weeks
Once every 1 week
Once every 2 weeks

Once an operation day

Once an operation

Once an operation

Once every 1-2 weeks
When first unboxing, after

laser tube replacement
Once every 1 month

Adjust when the optical
path misaligned

Once every 2 weeks

Depends on power, usage

hours, room temperature,
water temperature, etc.

Once every 3 months

Once every 1 month
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CH 5-2
Panel

The panel contains the machine interface
and the components underneath.




| CH5-2Panel

MAINTENANCE Page : It is recommended to check
Function Test once every 1 month.

Preparation Items : None

Maintenance Steps : After homing successfully, check the status display and switches except
for the "Laser Pulse”, and the standards are as follows

Status display

Camera Power = 1.00 Speed x 1.00

Motors Air Pump Pump Ventilator

Backlight = TouchSig Camled  Work Led Switches

Laser Pulse
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Status display Test method Icon

Opened Closed

Drawer Open and close the drawer [ =
Opened Closed

Door cover Open and close the door cover ! -
Oon Off

Water pump Press the “Pump” switch (start pump) - %
After pressing “Motors” to release the Triggered ~Not

X-axis motors, move the laser head to the left- triggered
limit switch most side of the machine until hearing a le le
clicking sound. (Trigger switch)

After pressing “Motors” to release the Triggered ~Not
triggered
Y-axis motors, move the laser head to the back-
limit switch most side of the machine until hearing a ? Y
clicking sound. (Trigger switch) S—
Not
) imi i Triggered ;
Z-axis bottom Manua\ly press the bottom |.H’T1It SWItCh triggered
L i in the lower right corner until hearing a ZL
limit switch s ; . — y 25
clicking sound. (Trigger switch) ] —
. Manually press the top limit switch in Triggered tr"g’\é%tred
Z-axis top ) ) .
. i the lower right corner until hearing a — —
limit switch — F 2

clicking sound. (Trigger switch) F &
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E \ | CH5-2 Panel

Switches :

- Camera : Check whether the camera view appears on the screen and move the laser head
to observe whether the screen keeps changing with the camera movement. (Camera view
is updated every 3 seconds)

- Motors : Check whether the laser head can move normally along the X-axis linear rail and
Y-axis guiding rods.

- Air Pump : Check whether there is air coming out of the laser outlet with a piece of paper,
as shown above.

- Pump : Open the door cover to check whether the blue light of the water pump is on (as
shown below) and whether the water pump icon on the screen is
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- Ventilator : After clicking, there will be a sound of acceleration and rotation, like the sound

of aircraft taking off.

- Backlight : The screen will turn black and then light up after clicking.
- TouchSig : The screen will be untouchable for 3 seconds after clicking.

- Cam Led : The light next to the camera, check if it can be normally illuminated, as shown

below.
- Work Led : At the front side and back side of the chassis, check if the light can be normally

illuminated, as shown below.
If there is any abnormality, please go to [Troubleshooting] (p.183) to find the solution.
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| CH5-2Panel

It is recommended to check

once every 2 weeks.

Screen Cleaning

spray a small amount of alcohol on a cleaning cloth

If the screen is dirty,

Maintenance Steps :

and wipe the screen lightly.

alcohol, 2 | Cleaning cloth

99%

Preparation Items : Self-preparation : 1| 75%




CH 5-3
Working Area

The working area includes the working
range and the laser optical path.

N




| CH 5-3 Working Area

It is recommended to clean and
re-lubricate once every 1- 2 weeks.

Lubricating

Maintenance Steps : Clean the Y-axis guiding rods, X-axis linear rail and 4 lead screws
regularly to extend the service life of the parts.

Preparation Items : Self-Preparation : 1| Paper towel or tissue paper, 2 | Cotton swab or brush
Included in the accessory box : 3 | Lubricating oil




1. Cleaning : Use paper towel or tissue paper to wipe the oil and dust on the Y-axis guiding
rods, X-axis linear rail and 4 lead screws.

1. Y-axis guiding rods 3. 4 lead screws (p.133 bottom)

2. X-axis linear rail 4. Height adjustment button
(p133 bottom)

=]
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] CH 5-3 Working Area

e

2. Oiling : Dip cotton swab or brush in the lubricating oil >

- Y-axis guiding rods and X-axis linear rail : Use at the Y-axis guiding rods on
both sides of the working range > Apply evenly above and on both sides of the X-axis
linear rail > Manually move the laser head left and right and forwards and backwards 3 - 5
times to distribute the lubricating oil evenly.

- Lead screws : Apply at the surface of the lead screws > Press the "Up" button and the
"Down" button to elevate and lower the honeycomb table once to distribute the lubri
cating oil evenly.




Honeycomb It is recommended to clean it once
Table Cleaning an operation.

Notes : To avoid the possible fire hazard due to the left of small pieces of engraving materials
on or beneath the honeybomb table, it is recommended to clean the honeycomb table
right after use.

Preparation Items : Self-preparation : 1| Vacuum cleaner or brush, 2 | Paper towel or tissue
paper, 3 | Air conditioner coil foaming cleaner

5

134



- The mesh part of the honeycomb table is relatively sharp, so please be careful
when holding.

- Perform a 2-second press on the "Autofocus” button to do the Z-axis homing to
avoid hitting the probe while taking out the honeycomb table.

- If the laser head cannot be moved, please click “MAINTENANCE” on the screen >
“Motors” to release the motors.

Maintenance Steps:

1. Take the honeycomb table out : Move the laser head to the upper right of the working
range > Press on the “Autofocus” button for 2 seconds to do the Z-axis homing > Lift up
the honeycomb table handles, hold the two sides of the honeycomb table, and pull it out.

2. Clean the honeycomb table : Use a vacuum cleaner or brush to clean the large residue and
dust > Spray the honeycomb table with the air conditioner coil foaming cleaner > Wait for
the tar oil to soften, then wipe it with paper towel or tissue paper to remove the tar.

3. Put the honeycomb table back : Place the honeycomb table at a 45-degree angle into the
chassis and lay it flat.

Height adjustment button




. . It is recommended to clean it once
Chassis Cleaning ;
an operation.

Notes : To avoid the possible fire hazard due to the left of small pieces of engraving materials

on or beneath the honeybomb table, it is recommended to clean the chassis right after
use.

Preparation Items : Self-preparation : 1 | Vacuum cleaner or brush, 2 | 75%-99% alcohol,
3 | Paper towel or tissue paper.

3.0l
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- The mesh part of the honeycomb table is relatively sharp, so please be careful
when holding.

- Perform a 2-second press on the "Autofocus” button to do the Z-axis homing to
avoid hitting the probe while taking out the honeycomb table.

- If the laser head cannot be moved, please click “MAINTENANCE” on the screen >
“Motors” to release the motors.
Maintenance Steps:

1. Take the honeycomb table out : Move the laser head to the upper right of the working
range > Press on the “"Autofocus” button for 2 seconds to do the Z-axis homing > Lift up
the honeycomb table handles, hold the two sides of the honeycomb table, and pull it out.

2. Clean the chassis : Use a vacuum cleaner or brush to clean the large residue and dust, or
gather them on the drawer, then open the drawer from the outside or push it out from the
inside of the chassis for cleaning.

3. Put the honeycomb table back : Place the honeycomb table at a 45-degree angle into the
chassis and lay it flat.

& iy %
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. Depending on the frequency of usage and
Mirrors and pending aueney d
. material,it is recommended to clean the
Lens Cleaning )
mirrors and lens once every 1- 2 weeks.

Maintenance Steps : If the engraving material is paper or wood, it is more likely to cause dust
and tar oil to stick on the reflective mirrors. You can use cotton swabs

with a small amount of alcohol to clean and wipe until the mirror surface
is free of stains.

Preparation Items : 1 | Cotton swab, 2 | 75%-99% alcohol

1

1

¥
3




| CH 5-3 Working Area

First reflective mirror

& Third
Second reflective
reflective ( mirror

mirror !! 7

Focus lens

There are 3 reflective mirrors and 1 focus lens that need to be cleaned in HEXA, and their
positions are shown in the picture.

After cleaning, the mirrors and lens should not be left with water marks to
avoid oxidation which may have an effect on the laser power, and should
not be wiped excessively as well.

Maintenance Steps:

1. Clean the first reflective mirror : The first reflective mirror is located at the left side of the
laser tube facing the chassis. You can open the back cover or wipe it from the front hole.
As shown below.




2. Clean the second reflective mirror : The second reflective mirror is located on the left Y-axis
guiding rod facing the chassis.

3. Clean the third reflective mirror : The third reflective mirror is in the triangular mirror holder
which is on the X-axis linear rail.




4. Clean the focus lens : The focus lens is located under the third reflective mirror, inside the
laser head.
a. Remove the honeycomb table >

b. Loosen 2 screws on the laser head cover and then move the cover aside >

/ : . o



d. Take out the focus lens and then clean it.




g Flat side

5. Put the focus lens back : The lens has an orientation, the convex side faces up, the flat
side faces down.

(Hold the edge of the focus lens on your hand and look towards the focus lens, you can
see yourself on the convex side and cannot see yourself on the flat side.)

If not installed according to the direction of the instruction, it may cause
inaccurate focus, resulting in blurred engraving or inability to cut.
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Optical Path When first unboxing, after laser tube
Inspection replacement, once every 1 month.

Notes : The optical path will be changed due to transportation and vibration of the working,
so regular inspection is necessary to ensure the correct laser optical path, so that the
machine can engrave evenly and cut normally.

Necessary inspection conditions : 1. The first time unboxing after long distance trans-
portation. 2. After replacement of the laser tube. 3. For regular maintenance, it is
recommended to check once a month.

Preparation Items : Included in the accessory box : 1| Double-sided tape



| CH 5-3 Working Area

First reflective mirror

X-axis
Third Y-axis
Seﬂcon(_:l reflective -
reflective mirror -axi
mirror 7 Z-axis
—,¥/ 7= — Focuslens: — — — — =)
/s
I ()

- |z

Inspection Steps :

1. Get the laser spots in the two corners : Hit the “MAINTENANCE” of the machine > Select
“Motors” > Move the laser head to the top left position > Put the double-sided tape on the
laser head outlet > Close the door cover > Make sure the laser “Power” is the default x 1.00
> Click “Laser Pulse” > Open the door cover > Make sure the laser spot is a full circle > Move
the laser head to the bottom right > Put the double-sided tape on the laser head outlet >
Close the door cover > Click “Laser Pulse” > Open the door cover > Make sure the laser spot
is a full circle. Get a total of 2 laser spots on the top left and bottom right.

Unable to get a full circle at both corners, you need to go through the
[Maintenance] Optical Path Alignment (p.146).




Optical Path

. Once every 1 month
Alighment

If the optical path is misaligned, the optical path should be realigned.
Signs of misaligned optical path : 1. engraved patterns will be deeper to lighter in a certain
direction; 2. the cut section is not vertical after cutting.

Preparation Items : Included in the accessory box: 1| 2.5mm hexagonal wrench, 2 | Torx
screwdriver, 3 | Double head wrench, 4 | Double-sided tape
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| CH 5-3 Working Area

First reflective mirror

X-axis
A~
DS Third Y-axis
Seﬂcontql reflective -
reflective - mirror -axi
mirror 7 Z-axis
4‘& = —Focuslens: — — — — =

- |z

Alignment Instructions :

1

The Y-axis direction is related to the first reflective mirror. After the first reflective mirror
is correctly adjusted, the laser spot got at bottom left position should coincide with that
got at top left position. When adjusting the first reflective mirror, put the double-sided
tape on the second reflective mirror.

. The X-axis direction is related to the second reflective mirror. After the second reflective

mirror is adjusted, laser spot got at middle right position should coincide with that got at
middle left position. When adjusting the second reflective mirror, put the double-sided
tape on the third reflective mirror.

. The Z-axis direction is related to the third reflective mirror. After the third reflective mirror

is adjusted, the laser spot should be in the center of the laser outlet. When adjusting the
third reflective mirror, put the double-sided tape on the laser outlet.

1.

Do not open the door cover when laser pulsing is in progress, otherwise the
laser will not emit light due to the protection mechanism.

. When aligning the optical path, the “Power” can be set to x0.50 in the

“MAINTENANCE” page to avoid the laser spot being too large to judge the laser
spot offset direction precisely. When the alignment is completed, the “Power”
needs to be restored tothe original po wer setting of x1.00 to avoid insufficient
power during use.

. If there is an abnormal cracking sound when starting the laser pulse, please

disconnect the power and stop using it immediately. [Troubleshooting] No Laser
Beam Output. (p.200)

. Please use the Torx screwdriver to remove the 2 screws on both sides of the

back cover and then lift the cover.

. Since there are threadlockers on the nuts of the first and second reflective

mirrors fixing mirror adjustment screws, dropping a small amount of alcohol on
those nuts is suggested to soften the threadlockers before turning the nuts.
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Alignment Steps:

Laser tube

Target : To confirm the laser spot is on the first reflective mirror.

Method :

1. Lift the back cover : Please use the Torx screwdriver to remove the 2 screws on both sides
of the back cover and then lift the cover.

2. Paste the tape : Take a piece of double-sided tape and paste it on the round metal frame
of the first reflective mirror.

3. Obtain laser spot on the first reflective mirror : Close the door cover > Click the “MAIN
TENANCE” on the screen > Click “Laser Pulse” > Open the door cover > Make sure the laser
spot is within the mirror, avoiding the frame of the mirror.

If the laser spot is on the frame, it indicates that the optical path is shifted too
much, so you need to move the first reflective mirror assembly to make the laser
spot fall into the mirror. (Use 2.5mm hexagonal wrench to loosen the 2 screws
on the bottom of the first reflective mirror assembly) > Adjust the position of
the assembly > Tighten the screws back). If the laser spot is weak (laser pulse at
screen power x 1.00, it takes more than 3 shots before the laser spot is visible),
then the laser tube should be replaced. [Maintenance] Laser Tube Replacement.

(p.1en)

Mirror frame

Reflective mirror




CH 5-3 Working Area

O, 7

First reflective mirror

Target : To make the bottom left spot coincide with the top left spot.

Method :

1. Release the motors and paste the tape : Click the “MAINTENANCE” of the machine to
finish the X and Y-axis homing > Click "Motors" > Take a piece of double-sided tape and
paste it on the metal frame of the second reflective mirror.

2. Obtain the top left laser spot : Move the laser head to the top left manually > Close the
door cover > Click “Laser Pulse” > Open the door cover > Confirm the laser spot position.
You need to observe how the next (bottom left) laser spot moves.

3. Obtain the bottom left laser spot: Move the laser head to the bottom left manually > Close
the door cover > Click “Laser Pulse” > Open the door cover > Confirm whether the bottom
and top left are overlapped at the same position and avoid the reflective mirror frame. As
shown in the picture above. If the laser spots are not completely overlapped, adjust the
mirror adjustment screw behind the first reflective mirror according to the direction of la-
ser spot movement, so that the bottom left laser spot position moves to the top left laser
spot position.

4. Adjust the first reflective mirror: Drop a small amount of alcohol on the nut to soften the
threadlocker > Use a double head wrench to loosen the nut without turning the mirror ad-
justment screw > Tighten or loosen the mirror adjustment screw according to the direction
of laser spot movement (control direction explained later) > Repeat steps 2, 3, 4 until the
bottom left laser spot overlap with the top left laser spot (if you can no longer determine
the direction of laser spot movement, you need to reapply the double-sided tape) > After
finishing the adjustment, tighten the nut without turning the mirror adjustment screw.

After confirming that the bottom and top left spots coincide and avoiding the reflective

mirror frame, adjust the second reflective mirror.

If there is no laser spot at the bottom left, please move to the middle left for
correction first, and then change back to the top left and bottom left for correction
after confirming that the middle left and top left points can be overlapped.
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Tightening or loosening screw is equivalent to adjusting the angle of the reflective mirror.

- When turning the yellow screw, the red and green screw link can be considered

as the axis of rotation.

By tightening the yellow screw (clockwise), you can think of pushing the mirror from the
upper left with the red and green as the axis, and the laser spot will move down to the lower
right. Loosening the yellow screw (counterclockwise), you can think of the red and green
as the axis to move the mirror backward in the upper left, and the laser spot will move up
to the upper left.

When you turn the green screw, you can think of the yellow and red screw link as

the axis of rotation.

By tightening the green screw (clockwise), you can think of the yellow and red as the axis
to push the mirror from the upper right, and the laser spot will move to the left. Loosening
the green screw (counterclockwise), you can think of the yellow and red as the axis to move
the mirror backward in the upper right, and the laser spot will move to the right.

When turning the red screw, think of the yellow and green screw link as the axis

of rotation.

By tightening the red screw clockwise, you can think of the yellow and green as the axis to
push the mirror from the lower left, and the laser spot will move up. If you loosen the red
screw (counterclockwise), you can think of the yellow and green as the axis to move the
mirror backward in the lower left, and the laser spot will move downward.

The rotation directions of The moving paths of the laser spots
mirror adjustment screws of on the double-sided tape on the
the first reflective mirror. second reflective mirror.
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Second reflective mirror
Target: To make the middle right spot coincide with the middle left spot.
Method:

1.

2.

Paste the tape : Take a piece of double-sided tape and paste it on the round

metal frame of the third reflective mirror.

Obtain the middle left laser spot : Move the laser head to the middle left

manually > Close the door cover > Click “Laser Pulse” > Open the door cover > Confirm the
laser spot position. You need to observe how the next (center) laser spot moves.

. Obtain the center laser spot : Move the laser head to the center manually >

Close the door cover > Click “Laser Pulse” > Open the door cover > Confirm whether the
center and middle left overlap in the same position. You need to observe how the next
(middle right) laser spot moves.

. Obtain the middle right laser spot : Move the laser head to the middle right

manually > Close the door cover > Click “Laser Pulse” > Open the door cover > Confirm
whether the spots overlap in the same position. If they are not completely overlapped,
adjust the mirror adjustment screw behind the second reflective mirror according to the
direction of laser spot movement, so that the middle right laser spot position moves to the
middle left laser spot position.

. Adjust the second reflective mirror : Drop a small amount of alcohol on the nut

to soften the threadlocker > Use a double head wrench to loosen the nut without turning
the mirror adjustment screw > Tighten or loosen the mirror adjustment screw according to
the direction of laser spot movement (control direction is explained later) > Repeat steps
2, 4 and 5 until the middle right laser spot overlap with the middle left laser spot (if you
can no longer judge the direction of laser spot movement, you need to reapply the dou-
ble-sided tape) > After finishing the adjustment, tighten the nut without turning the mirror
adjustment screw.
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The rotation directions of mirror The moving paths of the laser
adjustment screws of the second spots on the double-sided tape
reflective mirror. on the third reflective mirror.

. Confirm the spots of the middle right and the middle left overlap : Take a piece of
double-sided tape and put it on the frame of the third reflective mirror > Repeat steps
2 and 4 to confirm the overlap of the middle right and middle left spots and avoid the
reflective mirror frame, then fine-tune the laser head assembly position so that the over-
lapping spot is located on the perpendicular line of the round metal frame (black solid
line area in the figure).




] CH 5-3 Working Area

-~

7. Fine-tune the laser head assembly position : Use a 2.5mm hexagonal wrench to loosen
the 4 hexagonal screws on the X-axis linear rail that hold the laser head assembly in place >
Move the laser head forward or backward depending on the position of the spot > Roughly
tighten the 4 screws > Move the laser head to the center manually > Close the door cover >
Click “Laser Pulse” > Open the door cover > Confirm that the spot is on the perpendicular
line > Move the laser head to the chassis front > Click "Camera” and make sure the upper
and lower edges of the camera are parallel to the machine chassis > Fix the 4 hexagonal

screws of the laser head assembly. After confirming that the middle right and middle left
spots are on the perpendicular line of the round metal frame, you can adjust the third re-
flective mirror.
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Third reflective mirror

Target: To make the laser spot hit the center of the laser outlet.
Method:

1.

Paste the tape : Take a piece of double-sided tape and put it on the laser head outlet >

Gently press the double-sided tape to make a circle of laser head outlet indentation on the
tape's adhesive surface.

. Obtain the center laser spot : Move the laser head to the center manually > Close the door

cover > Click “Laser Pulse” > Open the door cover > Make sure the laser spot is in the cen-
ter of the laser outlet. If it is not in the center of the circle, you need to adjust the mirror
adjustment screw behind the third reflective mirror according to the position of the spot.

. Adjust the third reflective mirror : Use a double head wrench to loosen the nut without

turning the mirror adjustment screw > Tighten or loosen the mirror adjustment screw ac-
cording to the direction of the laser spot movement (the control direction is explained
later) > Repeat steps 3 and 4 until the laser spot falls in the center of the beam outlet (if
you can no longer judge the laser spot movement direction, you need to reapply the dou-

ble-sided tape) > After finishing the adjustment, tighten the nut without turning the mirror
adjustment screw.

The adjustment method is different from the first and second reflective mirror, because the
position of the mount under the third reflective mirror is fixed, so when the screw is tight-
ened, the mount will not move, but the reflective mirror will be ejected.
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- When turning the yellow screw, the red and green screw link can be regarded as the axis
of rotation.

Tightening the yellow screw (clockwise), you can think of moving the mirror backward in the
upper right with red and green as the axis, and the laser spot will move to the upper right.
Loosening the yellow screw (counterclockwise), you can think of the red and green as the
axis to push the mirror from the upper right, and the laser spot will move to the lower left.
When turning the green screw, the yellow and red screw link can be regarded as

the axis of rotation.

Tightening the green screw (clockwise), you can think of moving the mirror backward in the
upper left with the yellow and red as the axis, and the laser spot will move to the left. Loos-
ening the green screw (counterclockwise), you can think of the yellow and red as the axis
to push the reflective mirror from the upper left, and the laser spot will move to the right.
When turning the red screw, the yellow and green screw link can be regarded as

the rotating axis.

Tightening the red screw (clockwise), you can think of moving the mirror backward in the
lower right with the yellow and green as the axis, and the laser spot will move downward.
Loosening the red screw (counterclockwise), you can think of the yellow and green as the
axis to push the reflective mirror from the lower left, and the laser spot will move upward.
After completing the above adjustments, you can ensure that the laser beam output is uni-
form at any location in the working area to achieve normal working requirements. Please
perform "Calibrate Camera” again before use. [Beam Studio Tutorial]l Camera Calibration.
(p.058)

If the laser beam output verticality is strictly required, you can further adjust the verticality
of the optical path.

G @ s
The rotation directions of The moving paths of the laser
mirror adjustment screws of spots on the double-sided
the third reflective mirror. tape on the laser head outlet.
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Advanced adjustment : Verticality of the optical path (selective adjustment)

Target:To adjust the laser spots obtained from the laser head socket and from the laser head
outlet to the center of the circles.

Method:

. Paste the tape : Take a piece of double-sided tape and paste it flat on the frame of the third
reflective mirror.

. Get the center laser spot : Move the laser head to the center manually > Close the door
cover > Click “Laser Pulse” > Open the door cover.

. Measure the center offset value : Measure the distance between the center of the spot and
the center of the frame, x (mm). The laser spot should be located at the top of the perpen-
dicular line of the metal frame (as shown in the picture above). If the position is incorrect,
please contact your reseller.
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4. Move the third reflective mirror : Loosen the nut, use a double head wrench to loosen
the nut holding the mirror adjustment screw > Adjust the 3 mirror adjustment screws so
that the third reflective mirror and the triangular mirror holder are parallel and have x (mm)
spacing (as shown below).

5. Take the honeycomb table out : Move the laser head to the upper right of the working
range > Press on the “Autofocus” button for 2 seconds to do the Z-axis homing > Lift up
the honeycomb table handles, hold the two sides of the honeycomb table, and pull it out.
Please avoid hitting the probe while taking the honeycomb table out.

6. Adjust the third reflective mirror : Refer to the method of "third reflective mirror” and
adjust the laser spot to the center of the laser outlet again.

7. Move the laser head cover aside : Loosen 2 screws on the laser head cover and then
move the cover aside.

8. Paste the tape : Unscrew the nozzle fastening ring and remove the laser head (keep the
focus lens aside carefully) > Take a piece of double-sided tape and paste it flat on the laser
head socket, gently press the double-sided tape so that there is a socket indentation on the
adhesive side of the double-sided tape.

9. Obtain the center laser spot : Move the laser head to the center manually > Close the door
cover > Click “Laser Pulse” > Open the door cover > Observe the spot position and move
the third reflective mirror as appropriate.

10. Move the third reflective mirror (as shown below) :

a. The laser spot is in the center of the laser head socket, which means the optical path is
vertical and does not need to be adjusted.

b. If the spot is to the right, reduce the parallel gap of the reflective mirror and loosen the
3 mirror adjustment screws by half a turn, then repeat steps 6, 8-10 until the spot isin
the center of the laser head socket.

c. If the spot is to the left, increase the parallel gap of the reflective mirror and tighten the
3 mirror adjustment screws by half a turn, then repeat steps 6, 8-10 until the spot is at
the center of the laser head socket.

Note that the focus lens, laser head, and the nozzle fastening ring are installed when obtaining

the laser spot of the laser head outlet (step 6).
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11. Check the center laser spot : After the adjustment, make sure the laser spots got from the
laser head socket and from the laser head outlet to the center of the circles.

12. Install the laser head and its cover back : Put the laser head and its cover back > Tighten
the 2 screws of the laser head cover.

13. “Calibrate Camera” : Before using the camera preview function, please first “Calibrate

Camera”. [Beam Studio Tutorial] Camera Calibration. (p.059)
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Door Cover It is recommended to clean
Cleaning every 2 weeks.

Maintenance Steps : Spray a small amount of alcohol on the acrylic door and clean with a
cleaning cloth. The amount of alcohol should not be too much to avoid
cracking the door.

Preparation Items : Self-preparation : 1| 75%~99% alcohol, 2 | Cleaning cloth
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CH 5-4
Back Cover

The back cover includes the water pump,
laser tube and ventilation fan.
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| CH5-4 Back Cover

Depending on the power, hours of usage,
room temperature, water temperature
and other conditions.

Laser Tube
Replacement

Replacement 1. The degradation of the laser tube. 2. The failure of the laser tube which

Needed : has no laser beam output as well as generates a cracking sound. Laser tube
are classed as consumables, the degradation is normal due to the use of
power, storage time and other factors. The higher the power setting, the
faster the laser tube degradation.

Preparation Self-preparation : 5 | Needle nose pliers, 6 | Paper towel or rag, 7 | 75%~-99%
Items : alcohol, 17 | Water container, 18 | Scissors, 20 | Vacuum cleaner or high-pressure
spray gun *If you have one, it is better.
Included in the accessory box : 1| Torx screwdriver, 2 | 3mm Allen key, 3 | 2.5mm
Allen key, 4 | Double head wrench, 11 | Funnel
Included in the laser tube pack : 8 | Gloves, 9 | Aluminum box, 10 | Conductive
fabric tape, 12 | Aluminum box screws*2, 13 | Water pipe, 14 | Pipe clip*2,
15 | Hose connector, 16 | Pipe plug*4, 19 | Laser tube.

13 15 - 16 17 o

co2
Laser
Tube

Danger!

19
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. Please unplug the power cord first, then replace the laser tube.

. Please use the Torx screwdriver to remove 2 screws on both sides of the
back cover and lift the cover.

. You can remove the dust from the back chassis first and then replace the
laser tube. Use a vacuum cleaner or high-pressure spray gun to remove the
dust from the rear chassis, and then use a paper towel or rag with alcohol to
wipe the dirty area and wait for the chassis to dry before proceeding with
the next operation.

.The laser tube has two ends. The high-voltage side is near the screen and the
low-voltage side is near the reflective mirror.

. Please put a rag or paper towel on both sides of the high and low voltage to
avoid damage to the machine due to water seepage.

Replacement Steps :

1. Disconnect the laser tube wires :
a. Snip & detach: Please wear the provided gloves > Remove the cable wrapper > Snip the
copper part with scissors > Detach the white connector on the high-voltage side >
(If this is not your first time replacing a tube, please skip this step and remove the
aluminum directly with a 2.5mm Allen key.)

High-voltage side
white connector




§ Ground wire on
the laser tube
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b. Disconnect the laser tube wires : Press the white terminal and pull out the ground wire >
c. Remove the ground wire on the high-voltage side : Use the 2.5mm Allen Key to loosen
the screws in the EMI filter. Put out the ground wire connected to the laser tube.

2. Loosen the laser tube holders : Use the 3mm Allen Key to loosen a total of 4 screws on
the laser tube holders.




3. Detach the water pipes :
a. Move to the low-voltage side. Push the clamp outward with the Needle nose pliers >
Remove the hose connector and put it aside for later use > Remove the pipe clip on the
short hose and set it aside for later use > Make sure that the two water pipe openings
are inserted into the pipe plug to avoid water leakage.

Be sure to put a towel, rag or paper towel under the high-voltage and the
low-voltage side. Water leakage will cause the machine to malfunction.

b. To the high-voltage side, detach the water pipe (the laser tube can move from the tube
holder seats to the back cover, it will be easier to pull out the pipe) > Insert the pipe plug
after detaching >




5<4 Back Cover

c. Insert the supplied water pipe and plug it into the water inlet of the laser tube
to avoid to water leakage >

Avoid contacting the machine parts with water. If water leaks or
spreads, let the machine dry completely before starting up.

4. Remove the laser tube completely.




5. Place the new laser tube and water hose in :

a. Place the laser tube according to the picture >

b. Remove the water pipe plug on the high-voltage side and attach the water pipe to the
laser tube >




| CH 5-4 Back Cover

pipe clip

Ground wire

c. Move to the low-voltage side > Remove the pipe plug > Attach the pipe clip to the short-
er water pipe > Insert the hose connector > Use the needle nose pliers to move pipe clips
towards the connecting side to prevent water leakage.

d. Press down the white terminal and insert the ground wire > Release the white terminal >
Gently pull the ground wire to check if it is frimly connected.

. Apply conductive fabric tape, Install aluminum box and Grounding wire connection :

a. Connect the white connector at the high-voltage side and apply the conductive fabric
tape on the laser power supply’s connector >

b. Put the white connector into the aluminum box, mount on the cover and tighten the
screws with a 2.5mm Allen key. (The box can be put ramdomly in the space as long as the
cable and wires are not bent or twisted.)

c. Insert the ground wire on the high-voltage side of the laser tube into the screws position
on the EMI filter > Tighten the screw.

Laser power
supply’s connector

Conductive
fabric tape

EMI filter




7. Tighten the laser tube holders back :

a. Place the laser tube in position, leaving a finger distance between the tail end, about

15mm from the laser tube end to the first reflective mirror > Make sure there are no folds
or kinks of the water hoses >

b. Use the 3mm Allen Key to tighten a total of 4 screws on the laser tube holders > Gently
shake the laser tube to ensure it will not shift.
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8. Plug in the power cord and start the machine : After confirming the installation is correct,
you can plug in the power cord and start the machine.

9. Take out the water pump : Use a Torx screwdriver to loosen 4 screws on the water pump
cover > Take out the water pump.

10. Add water : Use the double head wrench to open the water pump cap > Put in the funnel >
Fill the water pump with distilled water > Click “MAINTENANCE” on the screen > Click
“Pump” after the laser head has finished the X and Y-axis homing. Then the cooling water
will start to enter the laser tube and the water level of the water pump will drop. Keep add-
ing water until the water pump level reaches 80% full and the water level no longer drops
due to the adding into the laser tube.

80% full




11. Tighten the water pump cap and the water pump cover back : Use the double head
wrench to tighten the water pump cap back > Place the water pump in its original place >
Tighten the 4 screws of water pump cover back with the Torx screwdriver.

. Make sure there is no folds or kinks of the water hoses to affect the water flow.

. Please use distilled water to avoid impurities affecting the water-cooling effect.

. Too many air bubbles inside the laser tube will affect the heat-dissipation
efficiency. It is recommended to fill the water to more than 80% full or press
the water hose when adding water, so it is less likely to produce air bubbles.

. Please observe the water level carefully to avoid overflowing.

. Please do not touch the area near the high-voltage side of the laser tube after
plugging the power cord in to avoid electric shock.

. When using the “MAINTENANCE” page, avoid touching the laser switch or
putting your hand at the laser tube tail end.

. If the water pump cannot be activated, please contact your reseller.

. After moving the laser tube, [Maintenance] Optical Path Alignment (p.146)
has to be conducted.
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Water changing
and adding

Once every 3 months

Notes : In order to avoid the breakage of the glass laser tube due to the heat generated
during laser excitation, it is necessary to maintain the water-cooling effect with
sufficient distilled water.

Preparation Items : Self-preparation : 1| Needle nose pliers, 2 | Paper towel or rag, 3 | Water
container
Included in the accessory box : 4 | Torx screwdriver, 5 | 3mm Allen key,
6 | Double head wrench, 7 | Funnel




Please turn off the machine and unplug the power cord before changing

and adding water.
. Please use the Torx screwdriver to remove the 2 screws on both sides of

the back cover and then lift the cover.
. The laser tube has two ends. The high-voltage side is near the screen and

the low-voltage side is near the reflective mirror.
. If the water is not overly dirty, please skip Step 1and Step 2 as after moving

the laser tube, the optical path must be realigned.

Maintenance Steps:

1. Disconnect the laser tube wires :
a. Press the white terminal and pull out the ground wire (Photo above) .

2. Remove the laser tube holders : Use a 3mm Allen key to loosen a total of 4 screws on
laser tube holders (Photo below) .

NV
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3. Remove laser tube to drain water out :

a. Place towel or paper towel underneath the laser tube in case leakage (Mind the laser
tube's position and angle) > Move both pipe clips away from the hose connector with the
needle nose pliers > Remove the joint from one of the hoses and immediately insert the
hose plug > Repeat the same for the other hose >

b. Drag the longer hose to the bottom side (High-voltage side) of the machine and put
the opening into the water container > Remove the hose plug to drain water (When the
water outlet at Low-voltage side is lower than High-voltage side, the water will drain due
to the Siphon Phenomenon) >

c. Lift the laser tube to drain the water completely. (Skip this step if choosing not to move
the tube.)




4. Place the laser tube back and put on the hose :

a. Place the laser tube in position as the photo above (Skip this step if choosing not to move
the laser tube.) >

Avoid contacting the machine parts with water. If water leaks or spreads,
let the machine dry completely before starting up.

b. Remove the plug at the High-voltage side and put on the hose.
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c. At Low-voltage side. put the clip on the shorter hose > Remove the plug > Insert the joint
on both hoses > Move both clips closer to each other to prevent leakage.

5. Connect the ground wire of the laser tube :
a. To the Low-voltage side > Press down the white terminal and insert the ground wire >
Release the white terminal > Gently pull the ground wire to check if it is firmly connected.
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6. Fix the laser tube holders : Make sure the distance between the laser tube and the first
reflective mirror is around 15mm (One finger’s distance)

7. Power cord and start-up : Plug the power cord and turn on the machine.
8. Water pump take out : Remove the back square plate with the Torx screwdriver > Take the
water pump out.




N

80% Full

———

9. Water Filling : Open the cap of the pump with double head wrench > Put in the funnel >
Pour the water in > Go to “Maintain Mode” and wait until it finishes homing > Press the
"Pump” button to turn the water pump > When water tank’s water decreases, pour in more
eater until the tank is 80% full.

10. Cap and back plate reassembly : Put back the pump’s cap and tighten it firmly with the
wrench > Place the water pump back in position > Fix the plate back by tightening these
4 screws with Trox screwdriver.



Ventilation Fan It is recommended to clean
Cleaning once every 1 month.

Maintenance Steps : Remove the dust from the ventilation fan with a brush, then wipe the
ventilation fan blades with alcohol.
Please check [Unboxing] (p.29) for the position of ventilation fan.

Preparation Items : Self-preparation : 1| Brush, 2 | 75%-99% alcohol.
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CH 6-1
Trouble-
shooting

This manual classifies the issues into three categories
according to their contents, including hardware, soft-
ware, and comprehensive issues. The test items and
solutions for each problem are explained here in order.

FLUX > “Supports” > “Help Center” has more resources to help users with
easy troubleshooting. If you cannot follow the guides from this manual or Help
Center, you need to collect relevant information (troubleshooting records) and

contact your reseller. *Please refer to 6-5 for the troubleshooting records and
contact your reseller with all the items in order to solve the problem faster.




Issue Category

Hardware

Software

Comprehensive

Issue Content (Error Code)

p.185
p.187
p.189

191

p.192

p.193

p.194

0.195

p.196

p.197

p.198

p.200
p.201

p.206

0.209

0.209

p.211

p.218

0.220

p.220

p.221

0.222

#900 Cooler Off

#901 Door Opened

#902 Overheated

#904

Homing Failed

#910 Z-axis Homing Failed ---

#911

Drawer Opened

#912 Abnormal Fire Detection
Abnormal Air

#913 Flow Detection

Abnormal Z-axis
top limit switch

Unresponsible motorized
work table

Material cannot
be cut through

No Laser Beam Output

Mirrors and lens are
oxidized or broken

Minor electric shocks
from chassis

Unable to Open
Software Properly

Other Software Error Codes ---

Connection Issue

Camera preview screen
stitching is inaccurate,
Actual engraving position
is different from camera
preview position

Camera Preview Timeout
or Failed to Connect

Camera preview speed is
too slow

Camera preview screen is
blurry

Camera preview screen is
overexposed

| CH 6-1Troubleshooting

Test Items

Water hose, water pump,
flow sensor

Door cover sensor magnet,
magnetic reed switch

Room temperature, water
temperature, water pump

Click “MAINTENANCE?” on the
screen to home the X and Y-axis

Do the homing, height adjustment
button, Z-axis bottom limit switch

Drawer sensor magnet, magnetic
reed switch

Air flow beneath the laser outlet,
air hose, T joint

Z-axis top limit switch, probe

height adjustment button

Focusing, power on the screen,
reflective mirrors and focus lens,
optical path, laser tube

Laser tube

Reflective mirrors and focus lens

Windows : Visual C++
Redistributable / macOS : Version

MAC Address, IP address,
“Test Network Settings”

Focus plane, camera calibration,

SVG file

“Camera” in the MAINTENANCE
page

Wi-Fi dongle, network
environment

Camera lens

Ambient lighting
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Lift the cover after removing the 2
#900 )
C I Off screws on both sides of the back cover
ooler with a Torx screwdriver.

Preparation Items : Self-preparation : 1| Distilled water, 2 | Water container, 3 | Cable tie,

4 | Diagonal pliers
Included in the accessory box: 5 | Torx screwdriver, 6 | Double head

wrench, 7 | Funnel




Air bubble inside
the laser tube

Test Items:

1. Click “Resume” button : Try to continue working, if no error message appears again within one
minute, then it can be used normally.

2. No folds or kinks of the water hose : If the water hose is obviously creased, press the area back
to the cylinder shape > Use the cable tie to fix the position.

3. The water pump should be at least 80% full : If the water level in the water pump does not
reach 80% full, water must be added [Maintenance] Water changing and adding. (p.171) >
Press the water hose to discharge the air bubbles inside the laser tube as many as possible.

4. Test the flow sensor : Test the flow speed, which should be above 3.0L/min : Machine screen >
“MACHINE” > “Hardware Settings” > “Test Flow Speed”.

5. Replace the cooling water : If you have tried steps 1~ 4 and still have an error, please replace
the cooling water [Maintenance] Water changing and adding. (p.171). It would be helpful if
you can record a video at the same time.

Troubleshooting Records:

1. Photo : Machine screen > “MAINTENANCE” > Turn on the “Pump” and take pictures of :
a. Water hose (bending at the connection)
b. Laser tube (the number of bubbles and flowability)
c. Water pump (water volume, water pump blue light should be constantly on)
d. Flow sensor (reading), as the right figure.
2. Video : The video of cooling water replacement should include the content of photos
(water hose, laser tube, water pump, flow sensor) to ensure that the above components

are working properly.
Water Temperature Threshold
Flow Speed |

Flow Speed: 3.82 L/min

I [
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#901
Door Opened

Preparation Items : Self-preparation : 1| Super glue

9,
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Magnetic reed switch
indicator light

Door cover
sensor magnet

Test Items:

1. Check the door cover sensor magnet : If the door cover sensor magnet is off but not lost
you can point super glue at the magnet base to glue the magnet back. If the magnet is
lost, please contact your reseller.

2. Test the magnetic reed switch : Open and close the door cover continuously, observe

whether the 2 indicator lights are obviously on and whether the door cover symbol is
displayed normally in the upper right corner.

Troubleshooting Records :
Door cover g 1. Photo :
opened a. Magnet (whether it is off)
b. Magnetic reed switch indicator lights (whether
they are obviously on)
2. Video : Need to include the action of opening and

closing the door cover and the change of the door
cover symbol.

Door cover
closed
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Overheated warning temperature can be adjusted in

"MACHINE" > "Hardware Settings” > "Water Temperature
#902 Threshold".

High water temperature will degrade the laser tube faster,
Overheated so it is recommended to prevent the overheated warning

by decreasing the room temperature instead of increasing

the water temperature threshold.

Preparation Items : Self-preparation : 1| Distilled water
Included in the accessory box: 2 | Funnel, 3 | Double head wrench,
4 | Torx screwdriver




Test Items:

1. Room temperature should not be too high:

a. Keep the right side of the machine heat vent open and should not shade the bottom air
intake.
b. Room temperature above 30°C is not suitable for the use of CO2 laser.

2. Water temperature should not be too high : The water temperature should be between
5°C-30°C.

The starting temperature of water is low, or the machine has good heat dissipation ability,
the continuous cutting time can be longer.

3. Reduce the high-power operation time :

a. If the water temperature is too high due to continuous cutting, you should wait for the
machine to dissipate heat and the water temperature to decrease before clicking "Resume”
for operation. This will not affect the engraving result. A suitable pause in cutting will help
to improve the heat dissipation and can effectively increase the continuous cutting time.

b. Arrange engraving works between the cutting jobs so that the laser tube can have enough
time to dissipate heat.

4. The water pump should be at least 80% full : More water will make the water temperature
rise more slowly. If the water level in the water pump is less than 80% full, water should be
added [Maintenance] Water changing and adding. (p.171) > Press the water hose to dis-
charge the air bubbles inside the laser tube as many as possible. The water-cooling system
of this model is a closed water circuit, if the water pump cap is covered, general use will not
cause water evaporation, the water level of the water pump drops, if the water level decreas-
es significantly within a week, please contact your reseller.

5. Water cooling fans work normally : Loosen the 8 screws on the side cover with a Torx screw-
driver and move the cover aside > Press the “"MAINTENANCE” on the machine screen > Click
“Pump”. After the water pump is turned on, you can check whether the 3 water cooling fans
are working.

Troubleshooting Records :

1. Photo : Flow speed reading (should be greater than I Flow Speed I
3.0 L/min) (“MACHINE” > “Hardware Settings” > “Test
Flow Speed”)

Flow Speed: 3.82 L/min
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#904 Since the reason for "#904 Homing Error" is
Homing rather complicated, please provide the trouble-
Failed shooting video to your reseller directly.

Troubleshooting Records :

1. Video : The complete X and Y-axis homing process should be recorded. The screen should
cover the whole machine. When the X and Y-axis homing process starts, focus on recording
the screen and sound at the top left of the machine. Manually pull the laser head to the
center of the working range > click “"MAINTENANCE” on the screen, then the laser head will
move up to the top and then move left to the far left to complete the X and Y-axis homing.
As shown in the picture.




#910 Since the reason for "#910 Z-axis Homing

. . Error" is rather complicated, please provide
Z-axis Homing the troubleshooting video to your reseller
Failed directly.

Test Items :

1. Test the height adjustment buttons : Press 3 buttons in turn to make sure the motion
along Z-axis is normal.

2. Test the Z-axis bottom limit switch : Take the honeycomb table out [Maintenance]
Honeycomb Table Cleaning, step 1 (p.135) > Click “"MAINTENANCE” on the screen > Press
the Z-axis bottom limit switch, and observe the change of its symbol from the screen.

Z-axis bottom limit Zl Z-axis bottom limit
switch: triggered —_ switch: not triggered

Troubleshooting Records :

a. The complete homing process should be recorded. (Press on the "Autofocus” button for
2 seconds to do the Z-axis homing.) Focus on recording the motion of Z-axis motor and its
sound.

b. Height adjustment buttons (whether they are functional)

c. Z-axis bottom limit switch (whether the symbol is shown correctly)

Height adjustment
buttons

Z-axis bottom
limit switch
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#911
Drawer Opened

Preparation Items : Self-prepartion : 1| Super glue, 2 | Magnet

/s Uy } 3
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Magnetic reed switch '

Drawer sensor
magnet

Test Items :

1. Check the drawer sensor magnet : After opening the drawer, check if the drawer sensor
magnet on the front of the drawer is over there. If the magnet on the drawer is off but not lost,
you can glue the magnet back. If the magnet is lost, please contact your reseller. Remove the
honeycomb table [Maintenance] Honeycomb Table Cleaning, step 1. (p.135) first, and push
the drawer out from the inside of the chassis will be easier to open the drawer.

2. Test the magnetic reed switch : Open the drawer > Click "MAINTENANCE” on the screen >
Take another magnet to cover the magnetic reed switch > Observe the change of the drawer
symbol.

Drawer opened = Drawer closed [N
—

Troubleshooting Records :

1. Photo : Drawer sensor magnet (whether it is off)
2. Video : Test the magnetic reed switch, including the use of external magnet, and the
change of the drawer symbol.

#912
Abnormal Fire Detection

The machine is in use, and (1) there is no flame generated, but the buzzer is making a buzzing
sound, or (2) there is a fire, but the buzzer is malfunctioning. Both situations indicate that
parts could be problematic. Please stop using the machine and contact your reseller. Repair
parts as soon as possible to keep the warning function works.
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#913
Abnormal Air Flow Detection

Preparation Items : Self-prepartion : 1| Paper

Test Items :

1. Check the air flow at the laser outlet (air pump) : Click "Air pump” on the screen >
Place a piece of paper at the laser outlet and test whether the laser head is blowing air
normally. [Maintenance] MAINTENANCE Page : Function Test, Switches - Air Pump.
(p.127)

2. No folds or damages of the air hose : If the air hose is obviously creased, press the
area back to the cylinder shape. If the air hose is worn to cause a leak, please contact
your reseller.

3. Check the T joint : Loosen the 8 screws on the side cover with a Torx screwdriver
and move the cover aside > Make sure the air hoses on the T joint are installed firmly.

Troubleshooting Records :

1. Photo :
a. Air hose (bending at the connection)
b. T joint (connections)

2. Video : Record the air flow change at the laser outlet before and after turning on the air
pump.




Abnormal Z-axis top limit switch

Test Items :

1. Test the Z-axis top limit switch : Take the honeycomb table out [Maintenance] Honeycomb
Table Cleaning, step 1 (p.135) > Click "MAINTENANCE” on the screen > Use a long tool such
as a pen to press the Z-axis top limit switch, and observe the change of its symbol from the

screen.
Z-axis top limit — Z-axis top limit ﬂ
switch: triggered z?T switch: not triggered

2. Check the probe : Double click the "Autofocus” button to do the focusing. When the motor-
ized work table is rising, kindly tap the probe. Then, check if the probe retracts and the table
stops moving.

Troubleshooting Records :

1. Video :
a. Z-axis top limit switch (whether the symbol is shown correctly)
b. Probe (whether it is functional)

Height adjustment
buttons =

Z-axis top
limit switch
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Unresponsible motorized work table

Troubleshooting Records :

1. Video : Press 3 height adjustment buttons in turn.




Material cannot Self-Preparation Items: As
be cut through described in the Test Items.

Test Items :

1. Make sure the focus is correct : Double click the “Autofocus” button to allow the motorized
work table to rise and let the probe automatically touch the surface of the engraving materi-
al. The distance between the laser head and the surface of the engraving material should be
12mm+Tmm.

2. Check the screen power setting : The power on screen is preset to x1.00. If the software
power and the screen power are multiplied by less than 15%, it is possible that there is no
laser beam output.

3. Make sure the mirrors and lens are clean and undamaged : Clean the reflective mirrors and
focus lens, please refer to [Maintenance] Mirrors and Lens Cleaning (p.138).

4. Make sure the optical path is not misaligned :

a. Put the double-sided tape on the first reflective mirror > Make sure the laser spot is on the
first reflective mirror.

b. Apply the double-sided tape to the second reflective mirror > Make sure the bottom left
and top left laser spots overlap.

c. Apply the double-sided tape to the third reflective mirror > Make sure the middle right and
middle left laser spots coincide.

d. Apply the double-sided tape to the laser outlet > make sure the laser spot is in the center.
If the above conditions cannot be met, it means the optical path is misaligned and needs to
be aligned [Maintenance] Optical Path Alignment (p.146).

5. Confirm that the laser tube is not degrading : If you have confirmed 1-4 items but still cannot
cut the engraving material, please contact your reseller.

First reflective mirror

X-axis
[
oS Third Y-axis
Sefcliontd reflective —
reflective - mirror Ay
mirror 7 Z-axis
4*; 7= —Focuslens — — — — =)
()

I~
—|
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Reflective mirror Focus lens

Troubleshooting Records :

1. Photo : Take pictures of
a. 3 reflective mirrors (whether there are stains)
b. Focus lens (whether there are stains)

c. Double-sided tapes on 3 reflective mirrors after optical path alignment (shapes and
colors of laser spots) Please stick the tapes as below, and press the “Laser Pulse” twice.

First reflective Second reflective il “nYq Third reflective

5

-

mirror o Mmirror mirror




No Laser Beam Output

Test Items :

1. Stop using the machine when there is an abnormal sound : If the laser outlet does not show
light and the laser tube makes a "cracking” sound during the use of the machine, it means that
the laser tube is malfunctioning, please stop using it immediately to avoid overloading the
power supply and causing damage to other parts.

2. Observe whether there is light in the laser tube : If there is no obvious noise but still no laser
beam comes out, please observe whether there is a light from the laser tube. Go to the “MAIN-
TENANCE” page > Make sure the power setting is x 1.00 > Close the door cover > Click on
“Laser Pulse” > At the moment of clicking, you should see a pinkish fluorescent light instantly
from the laser tube observation hole. If there is fluorescence, it means the laser is operating

normally, please refer to [Maintenance] Optical Path Alignment (p.146). If there is no fluores-
cence, please contact your reseller.

Troubleshooting Records :

1. Video : Record the laser tube observation hole status at the moment of pressing “Laser Pulse”
(whether there is pinkish fluorescence).

2. Photo : If there is pink fluorescence, please provide double-sided tapes on 3 reflective mirrors
after optical path alignment (shapes and colors of laser spots).
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Mirrors and lens are oxidized or broken

Preparation Items : Self-Preparation : 1| Needle nose pliers
Included in the accessory box : 2 | Torx screwdriver

R R

R VS pdia
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First reflective mirror

Third
Second reflective
reflective mirror
mirror
4“5 Focus lens

Oxidized reflective
mirrors

v

Test Items :

1. Check if mirrors and lens are oxidized or broken : If there are black spots, white spots, etc.
on the surface of the first, second, and third reflective mirror, or if there are serious scratch-
es, and the stains cannot be removed by [Maintenance] Mirrors and Lens Cleaning (p.138),
or if the focus lens is deformed or broken due to external force, the mirrors and lens should
be replaced.

Replacement Steps :

First reflective mirror :

a. Lift the back cover: Please use a Torx screwdriver to remove the 2 screws on both sides of
the back cover and then lift the cover.

b. Loosen the aluminum cover: Loosen the aluminum cover that fixes the mirror (face the
mirror and turn counterclockwise), if it cannot be turned, use needle nose pliers to clamp the
aluminum frame and turn again >

c. Replace the mirror: Take out the old mirror > Put the new mirror with the matte side facing
the mirror holder (laser beam will hit the shiny side) >

d. Tighten the aluminum cover: Tighten the aluminum cover back to the mirror holder.




« "

| CH 6-2 Hardware Issues

S

Second reflective mirror : After opening the door cover, follow the first reflective mirror steps
b~d (the position of the second reflective mirror is indicated in the picture in p.202).

Third reflective mirror :

a. Loosen the fixing cap: Use the needle nose pliers to hold the two round points of the fixing
cap of the mirror, and unscrew the fixing cap counterclockwise >

b. Replace the mirror: Take out the old mirror, you can pull out the mirror from the laser inlet
area > Place the new mirror with the shiny side facing the mirror holder >

c. Tighten the fixed cap: Use needle nose pliers to hold the two round points of the fixing cap
of the mirror, and tighten the fixing cap clockwise.
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Focus lens:
a. Remove the honeycomb table [Maintenance] Honeycomb Table Cleaning, step 1(p.135). >

b. Move the laser head cover aside : Loosen 2 screws on the laser head cover with a Torx
screwdriver and then move the cover aside >

c. Remove the laser head : Unscrew the nozzle fastening ring clockwise. If it cannot be
unscrewed, use needle nose pliers to assist > Remove the laser head, and please avoid the
focus lens from being popped out >
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d. Replace the lens : Remove the old lens > Put the new lens into the laser head with the flat
side downward (hold the edge of the lens and look into the lens, you can see yourself on the
convex side, but you cannot see yourself on the flat side) >

e. Put the laser head back : Put the laser head back > Tighten the nozzle fastening ring coun-
terclockwise >

f. Tighten the laser head cover : Tighten 2 screws on the laser head cover >

g. Put the honeycomb table back [Maintenance] Honeycomb Table Cleaning, step 3 (p.135).

Troubleshooting Records :

1. Photo : Take pictures of
a. 3 reflective mirrors (whether oxidized)
b. Focus lens (whether oxidized or broken)

! Reflective mirror

Focus lens

Convex side Flat side
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Minor electric shocks from chassis

Everyone's sensitivity to electric current is different, that is, everyone will have different de-
grees of feelings about leakage. Due to the design mechanism of the laser tube, there will
be a slight controlled leakage current for the tube to function properly, which is a normal
phenomenon, do not worry too much. The laser cutting machine must be properly grounded
while using. If it is properly grounded, there will be no leakage. If you touch the machine when
it is operating, and you may feel a minor electric shock, it maybe the 3-prong outlet is not
properly grounded, or the third prong is not fully grounded.

206

Preparation Items : Self-preparation : 1| Phillips screwdriver, 2 | Ground wire,

i

3 | 3-prong adapter

Ay

Solution :

1. DIY grounding : Connect the
machine’s power cord to a 3-prong
adapter > Connect the adapter's
ground terminal to the building's
metal piping to achieve an approxi-
mate grounding effect.

2. Wear shoes to use the machine :
Avoid using the machine with bare
feet, wearing shoes can reduce the
risk of electric shock.

3. Plug the adapter into the outlet
reversely : If you are unable to DIY,
connect the power cord to the
3-prong adapter and plug it into
the outlet in the opposite direction
(rotate 180 degrees).

&
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Unable to Open Software Properly

Windows

If your computer pops up a not responding window when you open the software, please
make sure you have installed Visual C++ Redistributable on your computer.

Please install Visual C++ redistributable packages for Visual Studio 2015, 2017 and 2019.

macOS
Please update your system to macOS 10.14 (Mojave) or above. Some older versions of macOS
may have support issues.

Other Software Error Codes

When the software is abnormal, error messages will pop up in your computer window. If you
are unable to follow the steps below to resolve the software issues, please contact your reseller.

Steps to Follow :

1. Record :
a. Record the current software and firmware versions.
b. Explain the operation behavior (or recording) and take screenshots.

2. Export a bug report : Export a bug report when an error message pops up.
(Menu > “Help” > “Bug Report”)

3. Retry: Reopen the software > Retry the behavior.

4. Check the Help Center : Go to official website “Supports” > “Help Center” to
search for solutions. (https:/support.flux3dp.com/hc/en-us)

5. Update software and firmware : Update software and firmware to the latest beta
version > Retry the behavior.

6. Record again : As in step 1.

7. Export another bug report : As in step 2.

Troubleshooting Records :

1. The information collected in steps 1, 2, 6, and 7.
2. beam files and image files, etc.
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Make sure that the MAC Address in the "NETWORK"
Connection of the machine screen has a value, IP address starts
Issue with 192168 and the network quality is good so that
you can have a stable connection.

Preparation Items : Self-preparation : 1| Ethernet cable (Wired Network*1 or 2, Direct

Connection*T)
Included in the accessory box: 2 | USB cable, 3 | Wi-Fi dongle

©

(B!
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Test Items :

1-1. There is a value for MAC Address in the "NETWORK" page :

—_—

~
0

——)

a. Wi-Fi :

- Built In Wi-Fi:

Click “"NETWORK” on the machine screen > Check whether MAC Address
under Embedded Wireless Network has a value, as shown below. If there is a
value, then please go directly to the 2nd test item. If there is no value, please
insert the Wi-Fi dongle and look the Extender Wi-Fi below.

Extender Wi-Fi:

Screw the Wi-Fi dongle firmly > Fold the dongle antenna up 90 degrees and
insert it into any USB socket on the side of the machine > Click “NETWORK”
on the machine screen > Check whether MAC Address under Extender Wire-
less Network has a value, as shown below. If there is a value, then please go
directly to the 2nd test item. If there is no value, please insert the Wi-Fi don-
gle into another USB socket for use. If neither socket shows the MAC address,
please contact your reseller.

b. Wired Network : (machine - router - computer, take 2 ethernet cables as an
example):

One RJ45 ethernet cable connects the machine to the router and the other
RJ45 ethernet cable connects the router to the computer > Click "NETWORK"
on the machine screen > Verify that MAC Address under Wired Network has a
value, as shown below. If there is a value, please go directly to the 3rd test item.
If there is no value, please try to replace the network cable or contact your
reseller.

c. Direct Connection (machine-computer) :

A RJ45 ethernet cable is connected to the machine and the computer on both
ends > Enable Internet connection sharing [Connection Settings] 2-5.4 Direct
Connection (p.053), Windows setting as 1, ¢, macOS setting as 2, c-e > Click
"NETWORK" on the machine screen > Check if the MAC Address under Wired
Network has a value, as shown below. If there is a value, then you can go directly
to the 3rd test item. If there is no value, please try to change the network cable
or contact your reseller.

Q

.,))

@ <€ Back

MAINTENANCE APP

Built-in Wireless Network
Wireless IP 192.168.1.39
MAC Address e8:4€:06:80:7c:42

@ i'i Ethernet IP
MAC Address e4:5f:01:2b:a9:45

Wired Network

Remote Assistance

NETWORK MACHINE w
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1.2. Network status is "Connected” :

USB Connection (machine~computer) :

A USB cable is connected to the machine USB-B slot and the USB adapter on
—] both ends. Install the USB-C of the adapter to the computer. > Verify that the
network status is "Connected.” [Connection Settings] CH2-5, 3. USB Con-
nection (p.051) * Windows setting as 1-b., macOS setting as 2-b., as below. If it
shows "Connected”, please go directly to the 5th test item. If it does not show
"Connected", please try to replace the USB cable or contact your reseller.

(] < i Network Q search

Location: Automatic

"y USCBOE::‘;;.edeX 2CAN Status: Connected

_—— USB Beambox 2 LAN is currently active and
—~ Wi-Fi has the IP address 10.55.0.5.
¥ @ Connected

Bluetooth PAN y . :
® Nt Chietat Configure IPv4: Using DHCP &
/) USB 10/1..1000 LAN IP Address: 10.55.0.5

© ot omeced Subnet Mask: 255.255.255.248
(=N Thunderbolt Bridge
@ Not Connected Router:

DNS Server:

Search Domains:

Advanced...  ?
+|—|©v

2. "Connect to WiFi": "Connect to WiFi" > Select the Wi-Fi you want to use > Enter the Wi-Fi
password and press “Confirm”.

a. If the Wi-Fi name is not displayed :

Make sure the Wi-Fi channel is 2.4Ghz, the machine does not support 5Ghz.

b. If Wi-Fi name is displayed, but you cannot connect to it :

Check the Wi-Fi encryption type, it should be WPA2 or None (no password). The encryp-
tion type can be set by your computer, but be aware that not all routers support WPA2.
c. Unable to connect to iPhone hotspot :

Make sure the phone hotspot name should not have special characters or non-English
characters. If the phone system is iOS 13, keep the hotspot page open when the machine
connects to the hotspot; if the connection fails, turn off the hotspot for about 10 seconds,
then reopen the hotspot and try to connect again.
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3. Confirm the beginning of IP address :
a. Wi-Fi:
Make sure the "Wireless IP" of the machine starts with 192.168.
b. Wired Network :
Verify that the "Ethernet IP" of the machine starts with 192.168.
c. Direct Connection :
Verify that the "Ethernet IP" of the machine starts with 192.168.
d. If the IP address starts with 169.254 :
If the IP address starts with 169.254, it means that the network interface card did not
obtain the IP address automatically. And usually this is because the router does not have
DHCP service enabled or the DHCP service is malfunctioning. Please contact your internet
service provider to turn the DHCP function on.

4. Fill the IP address of machine in Beam Studio: Fill the IP address starting with 192168 in
the software.
a. Windows :
Menu > “File” > “Preferences” > Machine IP Address > Apply.
b. macOS :
“Beam Studio” > "Preferences” > Machine IP Address > Apply.
c. Linux:
“Beam Studio” > “Preferences” > Machine IP Address > Apply.

5. Test the connection stability : If the software still cannot find the machine after filling the
IP into the software, please confirm the connection stability.
a. Menu > "Machines” > "Test Network Settings"” >

@ BeamStudio File Edit View Machines Window Help

3
P4

® (O] Machine Setup

Test Network Settings

beamo

Fortuna_C
Design team
Beamo (Hello)
beamo (Theo)
Fortuna_B

BB PEGGY
Beambox (Finley)

vV VvV WV WV WV VvV VvV VvV

s 00048R @«

If you have other connection problems, please refer to “FLUX > Supports >

Help Center > Beam Studio > Connection” for other instructions.
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b. Fill in the IP of the machine you want to use in "Target device IP address” > "Start" > (If
USB Connection is used, and the operating system is Windows, machine IP or so-called
Target device IP address should be 10.55.0.17. If the system is macOS, Target device IP
address should be 10.55.0.1.)

Network Testing

Local IP address: 192.168.1.44

Target device IP address:

c. The test data includes Connection Quality and Average Response Time >

| Test Completed

Connection Quality : 94 1
Average Response Time : 20.63 ms

After Beam Studio version 1.4.2, Connection Quality > 70 and Average Response Time <100ms
means the connection is stable. If the connection is stable but the software cannot find the
machine, please update the software and fill in the IP in “Preferences” > Machine IP Address. If
the connection is not stable, please check the Wi-Fi signal strength and whether the computer
and the machine are using the same network.
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Dongle antenna

Antenna

g connector
L]

Ethernet port

Troubleshooting Records :

1. Photo :
(M If any of Wi-Fi, Wired Network, or Direct Connection is used, connect the Built In Wi-Fi,

Wi-Fi dongle or ethernet cable > Turn on the machine > Click “NETWORK” and take
pictures of :

a. Antenna (connector, angle) or etherne port

b. Wireless Network MAC Address, Wired Network MAC Address

c. Wireless IP, Ethernet IP

d. Screenshot of the result of “Test Network Settings”

Q Q

-)))
.,))

€ Back

START Built-in Wireless Network

Wireless IP 192.168.1.39
MAC Address e8:4€:06:80:7c:42
Wired Network

Ethernet IP

MAC Address e4:5f:01:2b:a9:45

©

Remote Assistance
ID

MAINTENANCE APP
Connect to Other WiFi
@ "' Advanced Settings

NETWORK MACHINE Start Remote Assistance
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L X < > mE
Location:

) USB Bea...box 2 LAN

Connected
= Wi-Fi
¥ _ @ Connected

* Bluetooth PAN
@ Not Connected

(25 USB 10/1...1000 LAN
@ Not Connected

Thunderbolt Bridge
@ Not Connected

Network

Automatic

Status:

Configure IPv4:

IP Address:

Subnet Mask:

Router:
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"

Q Search

A
v

Connected

USB Beambox 2 LAN is currently active and

has the IP address 10.55.0.5.

Using DHCP
10.55.0.5

255.255.255.248

DNS Server: 10.5

Search Domains:

A
v

Advanced...

(2) If USB Connection is used, connect the USB cable > Turn on the machine and take
pictures of :
a. Network status (whether it is connected)
b. Screenshot of the result of "Test Network Setting

?
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Camera preview screen stitching is inaccurate,
Actual engraing position is different from camera
preview position

Accurate focus and calibration can make the preview picture stitching more accurate and
make the engraving position consistent with the preview position.

Test Items :

1. Confirm the correct plane of focus :
Double click the “Autofocus” button to allow the motorized work table to rise and let the
probe automatically touch the surface of the engraving material. Every time you change the
material of different thickness, you need to lower down the work table and do the autofocus
again to ensure the correct focus. When engraving, if the focus is not correct, the laser beam
will be thicker than the laser beam with correct focus.

Result of wrong focus

Result of correct focus
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Thicker object : When the object is thicker or when the rotary add-on is used, the side of the
object may be captured by the camera, and only the objects on the plane of focus can be
stitched together, and the picture out of focus and inaccurate stitching caused by the height
difference is normal. Be sure to focus on the surface of the engraving material and the highest
point of the engraving material when using the rotary add-on.

2. Complete camera calibration (left of below pictures) :
After exposing to shock and vibration of transportation, optical path alignment, and Reset
to Factory, etc., all need to be recalibrated. The calibration steps are as described in [Beam
Studio Tutorial] Step 2 (p.057).
There are two calibration objectives:
a. The red square must be located in the center of the calibration window.
b. The outside of the red square must be aligned with the center square of the grid lines.
3. Confirm the calibration result (right of below pictures) : Draw a square at (X)Y) = (77.5mm,
77.5mm) with a width W and height H of 25mm and make sure the square overlaps with

the center square of the grid lines. If it does not fit, refocus the paper and recalibrate the
camera.

-

——-lr-'-'-'-'i"il'-“_-‘q—

< > 25mm

25mm

v (X,Y) = (77.5mm, 77.5mm)

Troubleshooting Records :

1. Image file : If there is still a discrepancy between the result and the preview position after
using SVG file and confirming the correct plane of focus and accurate camera calibration,
please provide the SVG file to the your reseller and let the engineering team assist.
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Camera Preview Timeout or Failed to Connect

Troubleshooting Records : The reason for not
being able to use the camera may be related
to hardware or software, so please directly
provide the troubleshooting video to your
reseller for evaluation.

1. Video : The screen should cover the whole
machine, focusing on recording the machine
screen. Click "MAINTENANCE" > "Motors”
> "Camera" > Open the door cover > Slow-
ly move the laser head around the working
range for 3 rounds and observe whether
there is a picture on the screen, as shown
in the picture, if the picture is white, please
contact your reseller. (Note that the camera
updates the screen every 3 seconds.)

Camera preview speed is too slow

Test Items :

1. Wi-Fi dongle is not loose : Make sure the Wi-Fi dongle at the back of the machine is not
loose, and the antenna connector has been tightened.

2. Shorten the distance between the machine and the hotspot : Shorten the distance
between the machine and the wireless network source (router or hotspot), or try to use
wired connection. If the above items do not solve the problem of slow camera preview
speed, please refer to "Camera Preview Timeout or Failed to Connect” or contact your
reseller.

220



| CH 6-4 Comprehensive Issues

Camera preview screen is blurry

Test Items :

1. Check the cleanliness of the camera lens : Click "MAINTENANCE" on the screen >
"Camera" > check the cleanliness of the lens from the screen panel.

Preparation Items : Self-preparation : 1| Cotton swab, 2 | 75%~99% alcohol

e S




Operation Steps :

1. Clean the camera lens : Use a cotton swab with a small amount of alcohol to clean the
camera lens > Then use a dry cotton swab to dry the lens.

2. Confirm the camera screen :
a. Click "MAINTENANCE" > "Camera" > confirm the lens is clean from the screen panel.
b. Use the software Beam Studio camera preview function to confirm that the camera
preview screen is clean.

Camera preview screen is overexposed

Test Items :

1. Confirm that the environment is free of strong light interference :
a. Check that there is no strong light above the machine, such as track lights, flurescent
lamps, etc.
b. Make sure the machine is not placed in a place in harsh sunlight.

Preparation Items : Self-preparation : 1. dark fabric or cardboard.

Operation Steps :

1. Remove or shield the strong light source :
a. Cover the acrylic door cover above the engraving material with a dark fabric or cardboard.
b. Turn off the indoor light source above the machine.

2. Retry the camera preview : Make sure that the camera preview screen is back to normal.
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| 6-5 Contact Customer Service

FLUX > “Supports” > “Help Center” has more resources to help users with easy

troubleshooting. If you are unable to troubleshoot a problem according to this
manual or Help Center, please provide the following items to your reseller.

The following information is subject to actual use :

Name :
Telephone :
email :
Address :
Purchasing platform : For non-FLUX official website purchasers, please provide a
photo of the order details
Operating system : Windows / macOS / Linux
Software version : Windows: Menu > “Help” > “About Beam Studio”.
macOS: Menu > “Beam Studio” > "About Beam Studio”.
Browser: Chrome / Safari.
(Supported devices for browser version are those with either viewport
width or height is over 1024 pixels.)
Firmware version : Machine screen, "MACHINE” > Firmware Version.
Laser tube usage hours : Machine screen, "MACHINE” > Laser Tube Usage
Machine serial number : Please provide a photo of the sticker on the back of the machine.
Troubleshooting Records : Please provide photos or videos according to the Troubleshooting
Records in this chapter.

Contact your reseller to get a prompt support!

Contact FLUX:
Private message to Facebook fan page : https:./www.facebook.com/flux3dp/
email : support@flux3dp.com

Help Center
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v2021.12

As a FLUX consumer, you benefit under certain conditions from additional warranties.
FLUX offers specific consumer warranty benefits which are in addition to, and not
instead of, any legal warranties provided by your national consumer law. The duration
and conditions related to the legal warranties are provided by respective local laws.

Hardware Warranty

1. FLUX Inc. warrants only the hardware (excluding accessories and consumable parts*)
against defects in materials and workmanship when used as instructed in the manual for
the warranty period.

*Consumable parts include reflective mirrors, focus lenses, and vent hoses.

2. The limited warranty covers products purchased from authorized FLUX retailers against
defects in materials or workmanship.

3. Customers must provide the machine serial number and related information as proof of
purchase.

*Prior to returning any products, customers must receive an approval of shipping from
our authorized reseller via email or phone. We will not accept any unapproved re- turned
goods

4. During the product’s warranty period, FLUX may, at its discretion, take one or more of the
following actions: (1) send parts to customer along with tutorials for repair, (2) approved
return of the product to an authorized local reseller for (i) repair with new or refurbished
parts or (ii) replacement with a new or refurbished product provided that:

- The product was properly used according to the manufacturer’s intended purposes and
instructions.

- The product was not damaged due to acts of nature such as lightning, flood, or fire.

- The product’s casing was never disassembled without permission.

*Note : Particles, scratches, unevenness, or other appearance issues which do not affect
the function of the machine are not covered under the warranty.

5. Under the specified warranty period, our authorized local reseller may recall and repair
your products and absorb the local shipping fee (international shipping is not included)
without charging you.

Warranty Period

Warranty period starts at the time of customer receives the product. Please see the chart
below for the warranty periods.

Product Warranty Period
HEXA (Laser Tubes excluded) 12 months
60W Laser Tube 12 months
Rotary / Beam Air 12 months

Post Warranty Support and Repair

1. FLUX will continue to provide tech support via phone, email, and other online methods
even after the product warranty period.

2. After the warranty period, all costs—including but not limited to replacement parts,
shipping charges, and testing fees—are the sole responsibility of the customer.

3. Our authorized reseller may provide a quote for repairs.
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Disclaimer

1. FLUX Inc. does not warrant against normal wear and tear, items consumed or expended
by normal use, product misuse, or accidental damage.

2. FLUX is not liable under this warranty for any damages or defects caused by :

(M Improper (contrary to the stated purpose and scope of use described in relevant
documentation) use of Products or Add-ons;

(2) External force;

(3) External or internal inside;

(4) Lightning strike, overvoltage, power surge, or electromagnetic field.

(5) Unauthorized change, correction, or modification. Modification of the hardware or
accessories, including but not limited to replacing parts, making permanent cosmetic
changes to the machine, replacing the software or firmware, or other unauthorized
changes voids this warranty policy.

(6) Natural or human-caused calamities such as earthquake, war, fire, and flood.

(7) Improper storage, operation, application, or transportation.
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Appendix 1-1

Add-on
Introduction

With the use of different Add-on combina-
tion, the engraving materials can be diver-
sified.



| Appendix 1-1 Add-on Introduction

Note: Add-ons may not be available for specific regions / countries.

HEXA 1.5 inch
Focus Lens

Finer laser spots

Rotary Beam Air

Cylindrical object engraving Dust, tar and odor filtering
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| Appendix 2-1 Design Software Recommendations

Adobe
lllustrator

Vector graphics editor by Adobe Inc.

Affinity
Design

Vector graphics editor for Windows and
macOS by Serif Ltd

Sketch

Vector graphics editor for macOS by
Sketch BV.

D?S SolidWorks

Solid modeling CAD for Windows by
SolidWorks

Rhinoceros

3D computer graphics and CAD applica-
tion, abbreviated Rhino3D

Adobe
Photoshop

Raster graphics editor by Adobe Inc.

Autodesk
AutoCAD

Computer-aided design (CAD) and drafting

software application by Autodesk, Inc.

SketchUp

3D modeling program for architects, urban
planners, filmmakers, game developers, and
related professionals

(e\> Corel Draw

Vector graphics editor by Corel Corporation

Beam Studio supports the follow-
ing file formats :

SVG / PNG / JPG / DXF / PDF / Al
Version Support :

Beam Studio supported operating
system versions
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Exporting Adobe lllustrator SVG files :

If you are used to designing graphics in Adobe lllustrator and would like to export SVG files
for use in Beam Studio, please refer to the following steps to export files to avoid incompat-
ibility or non-support issues when importing into Beam Studio :

I. Make sure the strokes are center-aligned 1. Save the file:
before drawing : 1. Click “File” > Click "Save As...”.
Window - Stroke, set “Stroke” as "Align
Stroke to Center”.

.’ lllustrator File Edit Object Type Select E

¢ Stroke Gradient Transparer oo & -

New from Template... T8N
No Selecti .
o Selection Gpenn: 0 Unifor
PRV LAY Open Recent Files >

Browse in Bridge... X% 0

Weight: C 1 pt

Y

Close ®BW
Close All XB8W
Save ®8S

Save As... ¥ S

o 2 @ B
Corner: [ ff £F Limit

Align Stroke: Ji=

AR

S;

Save a Copy... X#S
Save Selected Slices...
Version History

Save as Template...

) @) HNN

o\
Ji
b

Revert
Search Adobe Stock...
Place...

[ ] Dashed Line

TN

Export
Export Selection...

N
&

Packana

2. Select "SVG (svg)" > Click "Save". 3. When the "SVG Options" window
pops up, click "More Options” in the
lower left corner.

Save As
S [ sveopo ]
SVG Profiles: | SVG 1.0 v
[ Creative Cloud Files 8 ~ a Fonts
Type: SVG
Subsetting: None (Use System Fonts)
Options
Adobe lllustrator (ai) Image Location: Embed v
lllustrator EPS (eps) [ Preserve lllustrator Editing Capabilities

Illustrator Template (ait)
Adobe PDF (pdf)
SVG Compressed (svgz)

e VG (svg) )

Use Artboards All O Range: 1

Cancel Save

Description

@ Hold the cursor over a setting for additional information.
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4. Please follow the screen below to set the SVG Options > Click "OK" to finish saving the file.

SVG Profiles: | SVG 1.0

Fonts

Type: Convert to outline

Options

Image Location: Embed =

[J Preserve lllustrator Editing Capabilities

Advanced Options
CSS Properties: Style Elements
[ Include Unused Graphic Styles

Decimal Places: 3 Encoding: Unicode (UTF-8)

[ Include Slicing Data
[J Include XMP

Responsive

Description

@ Hold the cursor over a setting for additional information.

IIl. Importing files into the software :

Import SVG files by dragging and dropping them into the Beam Studio window, or by

clicking the "Picture” [ button on the left side of the Beam Studio toolbar.
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Exporting Inkscape SVG files :

If you are used to using Inkscape to design graphics and willing to export SVG files for use

in Beam Studio, please refer to the following steps to export files to avoid incompatibility or

unsupported problems when importing into Beam Studio :

. Check the version of Inkscape : "Inkscape” > "About Inkscape”, it should be version 1.0 or
above.

1. Set the document properties before sketching : "File” > "Document Properties”, set the
Scale to 1.0 and the Units to mm.

@ Inkscape File Edit View Layer Object Pati eoe Document Properties (<3D)
o PS . s N |, 4 Document Properiies (©36D) e ® .
= NewiiTam Template... 3N Page. Guides Grids Snap Color Scripting Metadata License
L4 o
Open...
= Open Recent >
Lo Page Size
Revert
a [~ US Letter 85x11.0in
k 4} Save US Legal 85x14.0in
il US Executive 7.2x105in
B Save As... A0 841.0x 1189.0 mm
3 ~ Al 504.0x841.0 mm
l\ 7 Save a Copy... C e 4200x5040mm
83 A3 297.0 x 420.0 mm
7 save Template'" A5 148.0 x 210.0 mm
= sa ey T
l:‘ E Impor t... gnemaﬂon' O Portrait Landscape
El ustom size
O _UE Export PNG Image... {+3 E Width: 210.00000 -+ Height: 297.00000 -+ Units: mm v
'i X i » Resize page to content...
% ] Print... 8 P Scale
_{ Scale y: [1.00000 User units per mm.
@ 3 Clean Up Document —
@ E Document Properties... 08D Background Border
| Checkerboard background Show page border
“é__ o X Border on top of drawing
= Close c Background color: ‘Show border shadow
= 5 Display
Eg’ 5 Quit = [ Use antialiasing sordorcoor: [l
Zl(?’ 4 bk Bl it ke AW s el e b ik i e e b b
1Il. Save the file : Click "File"” > "Save As..." > Select "Plain SVG (*.svg)" > Check the box to
export as SVG 1.1 > "Save".
. . . . . T s B @@ @l e Ea @& BT
@ Inkscape File Edit View Layer Object
a
oce New =il _eoe® Select file to save to
New from Template... o
e = [T P Name: | GIENTTsvg
Open... #0
5 Open Recent > « e
’ Revert @ Desktop N:imc
a -400 D & . F\,‘ gpp\lcallegls .
ocument reative Cloud Files
k 5 Save #S B8 Creative Cloud Files soyo
4 Save As. N J Downloads Desktop
= o - - Documents
‘ = Save a Copy... N{O8S »@ Movies Downloads
[ Library
Save Template... dd Music B Movies
| Music
[ Pictures [ Pictures
Import [ Public
[ templates 0 E#Esvg
Export PNG Image... 038 E
E 4
Print... 8 P

+ Other Locations

Append filename extension automatically

Clean Up Document

Plain SVG (*.svg)

xport as SVG 1.1 per settings in Preference Dialog B SeNER Ao Ve € ovaz)

Document Properties... 38 D Compressed plain SVG (*.5vgz)
Optimized SVG (*.svg)
CIOSE 9P Compressed Inkscape SVG with media (*.zip)

| Desktop Cutiing Plotter (AutoCAD DXF R12) (*.dxi)

Quit W EOE DN ... .. oo (rocAD DXF R14) (.cx)

< 90200
L nuI|||T'|||||I|m“||||v|||||

2
5 &
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IV. Importing files into the software : Drag and drop files into the Beam Studio window or
click the "Image” button on the left side of the Beam Studio toolbar to import SVG files.
If you import SVG 11, a reminder window will pop up, click "OK" to continue using the

software.
o0 [O] drawing*
» layer1 > SVG Object
T
O
(@)
@]
AR e e o N O WARNING
2

The version of this SVG file is v 1.1, there might be
potential incompatibility problems.

(J Don't Show this next time.
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Inspirations :

Pinterest Idea Board : https:/pse.is/JXRR5
Ponoko 150 Laser Engraving ldeas : https:/pse.is/HQARL

Search for “laser engraving” on Pinterest.com for more ideas

@ Home laser Engraving X All Ping

@ Ideas projects @ @ @@ Ideas gifts Ideas metal e Glowforge

GlowILIgE SVL FE LuL LI

JAC OB e L 9 Laser cutting projects Honeybee Jo
Alexander Gibbs 9 ) ¢ Great Gift for
ek ko Rk ok

8} 3§ 20

Inches.

Laser engraving ideas
projects

Lasercut patterns;

LED Light laser engraving
machine

20 Crafty Us(
Engraver and

Tutorial: Wood Slice Christmas hi
Ornaments - Made with Forge Laser etching

CS =
1
J/"%f’mm

! 5 Common M
e Engraving an
150 Amazlng Laser Cuner mﬂ@h -

Graphic Resources :

The Noun Projects (free vector graphics) : https://thenounproject.com/
Freepik (free vector graphics) : http://freepik.com/

Wood Crafts & Paper Crafts :

DXF Projects (wood crafts) : https://dxfprojects.com/
Canon Creative Park (paper crafts) : http://cp.c-ij.com/sc/index.html
Paper-replika (paper crafts) : http://paper-replika.com/

Free Fonts :

Font-Bear (Japanese and Chinese characters) : https:/fontbear.net/
Dafont (English characters) : https:/www.dafont.com/
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To download the form, please go to “FLUX > Supports > Help Center” > Search : Mainte-
nance Checklist, download and print the checklist.

Q FILUX Products v Applications v  Supports v Store

Help Center .

Contact Us

Become a FLUX reseller. Create a futur!

Downloads

Warranty Policy

FLUX

Bring Any Design to Life

ebsite. If you continue

@ Submita request ~ Sign in

l beamo Guide ] l Beambox Guide ] l Beam Air Guide ’

{ Beam Studio \ { Beam Go \ { Changelog ’
{ Laser Material w { Network Wikipedia w { Delta Guide y

Maintenance Checklist provides the key points to be checked by users at different times,
please follow the instructions of [Maintenance] (p.121) for maintenance procedures.

Even if the machine is used sparingly, necessary maintenance items should
still be maintained on time to ensure the machine health. Leaving the machine
unused for a long time may accelerate the aging, regular use and proper main-
tenance is the way to avoid the machine from being out of action.
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Maintenance Checklist (HEXA)

o

Area Maintenance Content Key Points to be Checked
Panel Screen cleaning Clean the dust and grease off the panel.
Honeycomb Remove the residue and tar oil from the mesh
table cleaning* of honycomb table.
Working
Area
. _— Remove the residue and tar oil from the chassis
Chassis cleaning and bottom cover.
Water changing Add water and fill the water pump to more than
and adding* 80% full without a large amount of air bubbles.
Back
Cover
Ventilation fan cleaning Remove the dust from the ventilation fan blades.
I Cleaning the Y-axis guiding rods, X-axis linear
Lubricating* rail and 4 lead screws, and relubt"icate them.
Door cover cleaning Clean the grease off the door cover.
Working Mirrors and Clean the 4 mirrors and lens. Make sure they
Area lens cleaning* are not oxidized or left with water marks.

MAINTENANCE page*

Check the status display and switches except
for the "Laser Pulse".

Optical path inspection*

Make sure the laser spots got at two corners
(top left and bottom right) are full circles,
otherwise Optical Path Alignment has to be
conducted.

*: Necessary maintenance
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Date
1t month 2"9 month 3'Y month
Wi w2 W3 W4 W5 W6 W7 ws8 w9 W10 W11 | W12
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